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◼ Disclaimer 

CCH Software has made every effort to ensure the accuracy and 
completeness of this User Guide.  However, CCH Software, its 
staff and agents will not be liable for any errors or omissions 
and use of the software is subject to the customer’s licence 
with CCH Software.  This User Guide should not be relied upon 
as a detailed specification of the system or the software. 

CCH Software may make changes to this User Guide from time 
to time. 

◼ Copyright 

© 20198 Wolters Kluwer (UK) Ltd. This User Guide may not be 
copied, altered, edited, disposed of or distributed without the 
prior consent of CCH Software. The content is confidential. 

 

◼ Trademark Rights 

Microsoft, Windows, Windows NT, Windows for Workgroups, 

Windows 98, 2000, XP, MS-DOS Vista, Windows 7, Windows 8, 

Windows 10, Windows Server, Microsoft SQL Server, and 

Microsoft Office, are either registered trademarks or 

trademarks of Microsoft Corporation. Novell and NetWare are 

trademarks of Novell Inc. Citrix MetaFrame is a registered 

trademark or trademarks of Citrix Systems, Inc., All rights 

reserved.  
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Central is a registered trademark of MYOB Technology PTY 
Limited and is used by Wolters Kluwer (UK) Ltd under licence. © 
2008 MYOB Technology Pty Limited. Distributed under licence 
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CCH Accounts Production  

This User Guide provides a brief introduction to CCH Accounts Production (CCH AP). It is 
designed to assist existing CCH Accounts Production (VAP) users as they convert to CCH 
AP, as well as providing first time users with an introduction to the program. 

Installation 

It is recommended that you use the CCH Central Suite Installer to install AP 2018.2.  This 
will ensure that all pre-requisite requirements are available and installed in the correct 
sequence. 

For more information, please see the CCH Support Website here. 

 

Introduction 

CCH AP is deployed within the CCH Central framework. If you already use CCH Central 
you will be familiar with the user interface adopted in CCH AP and you will benefit from 
the sharing of the Central client and contact databases with CCH AP and your other 
modules. Users who are new to Central will benefit from the core features of the 
Central environment; centralised client and contact databases, task management, basic 
document management, reporting and home pages. 

Twinfield 

AP integrates with CCH’s cloud based bookkeeping system – CCH Twinfield.  For AP sites 
that have purchased Twinfield, slight variations in functionality and screen layouts will 
occur when compared to the information in this User Guide.  For full details about the 
Twinfield integration, please see the Twinfield User Guide. 

Licensing 

CCH AP is licenced based on a maximum number of concurrent users.  Each combination 
of user/workstation which opens one or more accounting periods within Central will use 
up one of the available licences.  Additionally, your licence will contain a restriction on 
the maximum number of jobs that can be created for the specialist master packs, for 
example ‘25 Academy accounts’. 

To view the current licencing arrangements and to see how many of the available 
licenses are being used, in Central click Help > About > Licensing.  If you require 
additional licences, please contact your Account Manager. 

http://www.cch.co.uk/softwaresupport/2011/resources/central_suite_installer/index.asp
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CCH AP Basics 

To access CCH AP, launch CCH Central and open the client that you want to work on. 
The client opens in a tab in the work area that itself contains a number of sub-tabs.  

Click the Accounts Production tab, and then double-click the accounting period that 
you want to process. 

 

 

The main Accounts Production tab will be opened showing the Homepage. 

 

 

Accounts Production Homepage 

The CCH AP Task Bar on the left is divided into two main areas. The Actions panel and 
the Navigation Area. The Navigation Area allows you to move between the different 
functional areas and the Actions panel displays the options that are available for the 
information currently displayed. 

 

If you use CCH Central in “Ribbon” mode, then the task bar Actions area is moved to 
the top of your screen, freeing up more space.  In this document, where references are 
made to actions on the task bar, you will instead find these on the ribbon bar. 

 

In most areas, Accounts Production works within a single tab. When you select a 
function from the Navigation Area, the system updates the Accounts Production tab, 
replacing the information currently displayed. To enable you to have access to multiple 
windows displaying different functional areas, the options are provided to open a 
function in a new tab and in a detached window. To do this, right-click on the functional 
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area in the Navigation Area and select Open In new tab or Open detached. If you open 
a function detached, you may now resize and move the detached window and place it 
on any monitor attached.  

 

 

Task Bar Navigation Area 

The Actions area displays tasks related to the selected functional area. 

 

Ribbon Bar Actions Area in “Ribbon” mode; 

 

 

 

Task Bar Actions Area in “Classic” mode; 

 

You can right-click functional areas 
and open the detached as floating 
windows, or in a new tab. 
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Accessing Prior Years’ Data 

The Accounts Production Homepage also contains the Period End drop-down: 

 

Period End on the CCH AP Homepage 

 

Period End This shows the period end date of the data currently being accessed. If you 
have more than one years’ data held, then you can click the down arrow to 
select an alternative period to work on. You can also select different 
accounting periods from the client’s Accounts Production tab as described 
earlier in CCH AP Basics. 

 

Summary Errors and Exceptions 

CCH AP provides both real time and passive reporting on potential issues that affect the 
validity of the accounts being produced.  There are three sources of information that 
can assist the user: 

1) A list of real-time errors and exceptions that have occurred during the entry of 
accounts data appears under Summary at the bottom of the CCH AP Homepage.   

Period End drop-down list 
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Errors and Exceptions on the CCH AP Homepage 

You can double click on an entry in the list to display the functional area within 
CCH AP that requires your attention.  

The buttons that run along the top of the Errors and Exceptions panel allows you 
to filter the messages shown e.g. if the Warning button is selected then only 
warnings are displayed. 

 

Hint: If you use CCH Workflow or CCH Working Paper Management, then the Errors 
and Exceptions Panel will also contain tabs relating to these modules: 

 

 

Hint: The errors and exceptions panel can also be viewed within the Statutory 
Database screen if required.  Simply drag the splitter located at the bottom of the 
tree up to reveal the errors and exceptions panel. 

 

2) In the FRS102 master packs, certain formats have reconciliation checks and warning 
messages that will be triggered if certain conditions are not met, for example if the 
cash flow is out of balance. 
 

3) Thirdly, additional errors, exceptions and warnings are shown on the Exception 
Report formats.  These can be found in the Management Collection for certain entity 
types. 

 

“Job Summary” Homepage 

There is a Central home page control provided which lists all the clients that have one 
or more accounting periods.  This list can be filtered to display only those linked to the 
current Employee’s Office, Department, Manager or Partner etc. 

To add this control to your home page, click the Home Page tab, then click the 
“Customise homepage” task, select the Accounts group and drag the Job Summary 
control onto the tab, then position and resize as required. 
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Simply click the hyperlink on the Period End date to open that accounting period in a 
new tab. 
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Client Management 

Creating a New Client 

To create a new Central client, select FileNewClient from the menu.  This opens 
the Add New Client Wizard.  This wizard contains 6 steps and tabs: 

Main Details This contains 2 mandatory fields, Code and Last Name, plus other 
information about the client being created. Enter the Code to be used 
for the client and the other data requested. For a company, the last 
name field will be relabelled Main Name and you should enter the 
name of the company here. 

Extra Fields If your practice has defined any mandatory extra fields, you will need 
to click Next, or click on the Extra Fields tab and enter these.  

Accounts The Accounts tab is where you enter the data relating to the first 
accounting period to be created. You can access it by clicking on the 
tab or by clicking on Next until it is displayed. 

The other tabs in the wizard contain optional data which can either be completed when 
the client is created or may be entered later. 

As indicated, the Accounts tab allows you to create the Accounts Production related 
data for the client. The default setting is not to create accounting data. If you create a 
client without accounting data, this can be added later via the Accounts Production 
tab, for details refer to the next section. Please refer to the Central documentation for 
full details of the client creation process. 

To create accounting data when creating the client, select the Create accounting data 
for this client option: 
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Client Creation Wizard Accounts tab 

The only field in this dialog that may be left blank is Registration No. 

Type  Allows you to select the entity type from a drop down list of entities 
defined for the system. When you select an entity, the system will 
populate the remaining mandatory fields with the default data 
defined in the associated master pack. 

 HINT; You can hide entities you do not use from the maintenance 
screen; Maintenance > Accounts > Entities.  Tick the “Hidden” 
box. 

Master Pack This will default to the latest version of the master pack available. 
Select a different version if you wish to use an earlier version of the 
master pack. You may wish to do this if the current master pack 
reflects current legislation but you are preparing a set of accounts 
under previous legislation. 

Chart Some master packs contain multiple charts and you can select the 
chart to be used from the drop down. 

Year Start Enter the first day of the accounting period to be created and the 
system will auto populate the Year End field.  

 Note on comparatives 

 The system draws the comparative data directly from the prior year’s 
accounting data. In the first year you process a client’s data, you will 
need to set up at least 2 accounting periods, the current year and the 
prior year to hold the comparatives. You can therefore either set up 
the prior period as the first year, enter the TB and any comparative 
statutory database data required and balance forward to the first 
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year to be processed, or create the current year and later create a 
prior year from the Homepage Actions option. 

Year end Will be generated automatically based on the year start date, but can 
be edited to reflect periods of less than or greater than a year. 

Theme The Theme drop-down defaults to the CCH Theme if no others are 
installed. If you are using additional themes then the Theme drop-
down defaults to the first theme based on alphabetical order. Themes 
are used to allow you to select system wide fonts and styles for use 
when printing accounts and are maintained via 
MaintenanceAccountsThemes. 

Twinfield If you have purchased CCH Twinfield, our cloud-based bookkeeping 
system, you can connect the AP dataset to the Twinfield job here. 

Workflow type Central Workflow. This refers to the usual Workflow option in 
Central. If selected, then you can choose which Workflow to use by 
default when the first Accounting Period is created for a client. It is 
also the default when you roll forward to a new year, even if a 
different Workflow was selected for the earlier year. 

 None. In this case no Workflow will be selected by default when an 
Accounting Period is created for a client, either for the first 
Accounting Period or at Year End for a subsequent period. 

Click on Finish and the client will be created. 

Create Accounting Data for an Existing Client 

For a client currently with no accounting data 

If you wish to create accounting data for a client that already exists in Central but for 
which no accounting data currently exists, you can do this via the Accounts Production 
tab. When you select this tab you will see the following: 

 

New Period on the Accounts Production Tab 

Click the row entitled: Click here to add new Accounting Period and the Create 
Accounting Period dialog will be displayed. This dialog requests the same information 
as the Accounts tab of the wizard described above. 

Creating comparative data for a client with 
accounting data 

If you have created the first accounting period that you are going to process but you 
have not yet created the prior period to hold the comparative data, you can do this by 
selecting Create Prior under Actions when the Homepage is displayed.  
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On selecting this, the system will display the Create Accounting Period dialog, 
populated with the required information. In this case the only fields available for edit 
will be Name, Year Start and Theme. 

  

Create Accounting Period Dialog 

 

Opening an Existing Client 

To open an existing client, click the Clients button on the toolbar to display the Find 
clients tab. 
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This initially contains an empty list. To search for a client, enter part or all of the 
client’s name or code in the Search for field and then click Search. A list of all clients 
meeting the entered criteria appears. To open the client, double-click the client’s 
name. To display a list of all clients, leave the Search for field blank and click on the 
Search button. 

The system also maintains a list of recently accessed clients and contacts and displays 
them in the File menu. You may also open a client by selecting it from this list. 

For more information regarding client creation, opening clients and other related 
options refer to CCH Central’s Help via HelpHelp Topics on the main menu.  

Travel Clients 

Travelling clients allows you to take the Accounts Production and associated Central 
data for clients out of the office to work on offline. To travel data, click the Clients 
button on the toolbar to display the Find clients page. Locate the client that you want 
to travel, select the check box to the left of the client code and then click the Travel 
Client option under the Find Tasks group on the Task Bar. A local copy of the data will 
be created and a confirmation message displayed once the process is complete.  See 
Opening an Existing Client for further information on searching for clients. 

The next time that you log into Central on the computer on which you travelled data, 
you will see a new Central data set in the list bearing the code of the client that you 
have travelled. If you select this then a new Central environment will be created on the 
local computer, this will allow you to edit the Central data and work on the accounting 
data for the travelled client while away from the office. 

You may travel any number of clients each of which will be stored in a separate data set 
for use out of the office. 

While working in a travelled client, it is possible to create ad-hoc backups of your data 
by clicking Help > About > Backup Database. 
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Restoring Travelled Data 

To restore travelled data, open the Central data set containing the travelled client and 
select FileSynchronise from the menu. The system will merge the updated travelled 
data into the office database displaying a progress messages as it proceeds. At the end 
of the process it will back up the offline database in case you need to access it later. 
Finally, the offline Central data set is removed from the list of available data sets. 

After restoring the travelled accounting data, it is necessary to synchronise any changes 
made to the Central contact records. This is done using a homepage control that 
displays a list of any restored clients where changes to the Central records have not 
been reviewed and accepted. 

Adding Central homepage control 

To add the homepage control, ensure that the current homepage displayed has space to 
hold the control, select Customise homepage from Other tasks in the toolbar and a 
Toolbox will appear. 

 

If the Central controls are not visible, click on the Central button. Drag the Data to 
import control to a clear area on the homepage and resize it by dragging the borders as 
required. You can rename the homepage by clicking on its current name in the Task Bar 
under Views. Close the Toolbox using the close button identified by the red cross. 

 

 

 

Using the homepage control 

This control lists any restored travelled data where any changes to Central records have 
not yet to be reviewed and accepted. To review the changes, double click on the entry 
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and a new tab will appear listing any changes that have been made to the Central data 
while offline. To accept the changes click on Apply from the Task Bar. If you do not 
want the local changes reflected in the office Central database, click on Cancel 
changes. You instruction will be processed, the tab closed and the record will be 
removed from the homepage control. 

Import/Export of Clients (new method) 

 
A new facility has been added to allow users to transfer Accounts Production clients from 
one Central database to another via an Export from one database and an Import into the 
second. The option is similar to the facility that is available in other Central applications such 
as Personal Tax, Fixed Asset Register and Corporation Tax. 
 

Export Screen 

 
The Export screen is accessed through File > Open > Import/Export. It is used to export CCH 
Accounts Production data for a client (or clients) so that it can be imported on another 
Central 
database. 
 
The Export screen leads you through a wizard with several screens. 
1. Select Client(s) to Export 
‒ A Search control at the top of the screen allows you to limit the clients displayed to 
those matching part of a Code or Name 
‒ Click the columns headings to sort by Code or Name. 
‒ Tick the clients you wish to export. 
‒ Click Next to move to the next screen. 
 

 
 
2. Select Export Folder 
 
‒ Click Browse to choose the folder where you want to save the exported client(s). 
‒ Click Next to move to the next screen. 



CCH Accounts Production  General User Guide 

 

© 2019 Wolters Kluwer (UK) Limited  14 

3. Exporting 
 
This screen shows the progress of the export. 
 
4. Export Complete 
‒ This screen notifies you of success or failure. 
‒ Click Finish to exit the wizard. 
 
Notes 

• The export creates one zip file per client. 

• Exporting a client does not remove it from the source database or lock it in any way. 

• The new Export option should not be confused with the old Actions > Export 

option. The old 

• option was used to send a client into CCH Software Support for investigation. The 
data could 

• not be sent back. The new option comes with a matching Import option, creates 
smaller files 

• and runs more quickly. It is possible that the old Export option will eventually be 
removed. 

• Access to the Export option is controlled by Task Permission: Accounts Production > 

Other>“#Accounts #Export Clients”. 
 

Import Screen 

The Import screen is accessed through File > Open > Import/Export. It is used to import 
Accounts Production data for a client (or clients) that was previously exported. 
 
The Import screen leads you through a wizard with several screens. 
 
1. Select the Source of the Import 
‒ There are two ways to import data 

• Click here to select the file to import Use this link to browse to an import file. 

• Batch import data from a folder Use this link to select a folder containing multiple 
import files to import 

 
‒ Click Next to move to the next screen. 
 
2. Select data to import 
 
‒ If a folder was selected containing multiple files, you can select which files you wish to 
import. 
 
‒ The client is shown and if it already exists on the Central database, a warning is displayed 
“Warning: Client code already exists. Existing Accounts Production data will be deleted”. 
If you wish to avoid this happening, you can enter a substitute code under Import As. In 
the example below BAL1 already exists on the database and the user has decided to 
import the data on a new code, NEW1. 
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‒ Click Next to move to the next screen. 

 
‒ If any clients will be overwritten, you are asked if you wish to proceed. Click Yes. 

 
3. Importing Data 
 
‒ This screen shows the progress of the import. 

 
4. Import Complete 
 
‒ This screen notifies you which clients have been imported, which failed and of any 

warnings that the Import tried to correct. 
‒ You can now Export the notifications to Excel. 

‒ Click Finish to exit the wizard. 

 
Notes 

• If the client already exists in the destination database, only its Accounts Production 
data is overwritten on import. Data relating to other products, eg CCH Personal Tax, 
is untouched. 

• The AP export file contains the AP data and a little data about the client. If the client 
does not already exist in the destination database, then the client data in the export 
file is used to create it before the AP data is imported. But this will not be a full 
record of everything on the client that was on the source database. For instance, the 
client’s Department, Company, Office, Partner and Team Member are all missing as 
they are “outside” the client. Also the Initials are not refreshed from the First and 
Middle names. You may wish to make these changes manually 

• f you wish to duplicate an AP client on a Central database, you can export the client 
and immediately reimport it. On reimporting, give the client a new code. The client 
is then created a second time. 

• If you import a group, including its parent and subsidiaries, then the group company 
is automatically imported after the parent and subsidiaries. On importing the group 
company, the parent and subsidiaries are set up in the Consolidation Group screen. 
If you just import a single subsidiary (or parent) that already belongs to a group in 
the destination database, the subsidiary accounting periods are deleted first, 
removing the company from the Consolidation Group screen and the new 
subsidiary is imported, but it is not re-added to the Consolidation Group screen. So, 
if you need to import just a single subsidiary then you should update the 
Consolidation Group screen manually afterwards. 
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➢ Access to the Import option is controlled by Task Permission: Accounts 

Production > Other>“#Accounts #Import Clients”. 
 

Limitations 

• The Export only exports client data. No master data is exported or imported. So, if a 
practice master pack is created on the source database, then it should also be 
created on the destination database, which is a manual process. Although the Export 
cannot transfer a practice master pack, any local pages are transferred across as 
they are part of the client data. 

• f the master pack version of the exported data is not found on the destination 
database, then the Import uses the next highest master pack version number. This 
could cause the imported client to have fewer (or more) accounts pages than the 
exported client if the exported client used a practice master pack that does not exist 
on the destination database. 

• The Export only covers Accounts Production data. The Fixed Asset Register has its 
own Import/Export functionality. Working Papers Management data is not included. 

• If the version of Central on the destination database is different from that on the 
source database, then the user is warned, and the data is not imported. This means 
that the Export function cannot be used as a method for backing up individual 
clients, eg at Year End, as you would not be able to restore the backup after 
upgrading to a new version of Central. 

• There are two types of error that can occur during the Import: 
o Warning. A warning is a problem that the Import tries to recover from. It is 

listed in the notifications at the end but does not prevent the Import from 
completing. 

o Error. An error is a problem that the Import cannot recover from. It is listed 
in the notifications screen and none of the new accounting periods are 
imported. If the client existed before, the old accounting periods are not 
overwritten (or they are reinstated if they had already been deleted when 
the error occurred). If the client did not exist before, then the new client is 
imported but with no accounting periods. 

 

Export a Client (old method) 

Exporting a Client allows you to create a set of files containing the Accounts Production 
data for a Central Client.  These files can then be sent to CCH Support if required, so 
that the data can be investigated.  This is significantly easier than having to provide 
entire SQL database backups. 

Note that there is no facility to “import” the data into another Central database. 

To export data, click the Clients button on the toolbar to display the Find Clients page. 
Locate the client that you want to travel, select the check box to the left of the client 
code and then click the Export Client option under the Find Tasks group on the Task 
Bar. A local copy of the data will be created and a confirmation message displayed once 
the process is complete. 

Contacts 
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Central has the facility to maintain details of contacts as well as clients. Contacts are 
created via File  Add contacts and on selecting this you will be presented with the 
same Wizard used for creating clients. However, for contacts a number of the fields, 
e.g. Code will be disabled and the Accounts Production tab will not be visible. 

Contacts are used to hold data centrally that can be linked to any number of clients’ 
accounts data to record such things as: 

◼ Directors and other officers 

◼ Auditor or accountant 

◼ Banks 

◼ Solicitors 

◼ Other more specialised third parties such as Investment advisors 

They can also be used to store the registered office address, or this can be stored as an 
address record, see below. 

Associations 

Association is the mechanism by which contacts are associated with clients. Any number 
of association types can be set up to describe any relationship. Each association type has 
two sides to describe the association from both sides, the client and the contact, e.g. 

 For client    For contact 

 Has Director of    Is Director of 

 Has Bank of    Is Bank of 

Once the association is made in Central its details become visible in any accounting 
period to which it is relevant. Relevance is determined by the start and end date set for 
the association. If the start date is before the accounting period end date and/or the 
end date is after the accounting period start date, the association will be relevant to 
the period and will be used in the financial statements. 

To add an association 

From within the client or the contact’s record, select the Association tab. The system 
will display the existing associations for the record: 

 

To add an association, select Add from the Association group in the Task Bar. The 
system will display the Associate existing contact dialog: 
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Select the type of relationship being crated, for example if you were adding details of a 
director and you were in the company’s record, click on Has Director of.  

 

 

 

(If you were doing this from the Director’s record you would select Is director of.) 

Next, click on the Browse button at the end of the Contact field to find the contact 
that is the director: 

 

Enter the name, or part of the name, of the person you are looking for and click on 
Search.  
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If you have the system set to automatically select the contact if only 1 record is 
returned, and only 1 is found, the contact will be auto selected, otherwise highlight the 
contact required and click on OK. You can also double click on a contact’s name to 
select it. 

Enter the start and/or end dates for the association and click on OK. 

For some associations, such as Directors, you need to provide additional information to 
be disclosed in the financial statements and this is covered later. 

Addresses 

Any number of address records can be created and addresses can be linked to multiple 
clients. Address records are used to store the main business address and can also be 
used to store the registered office. How the accounts formatter obtains details of 
contacts and addresses is user definable and is described below. 

To view or maintain addresses, open a client and select the Addresses tab. 

 

Select the option Add/ Maintain on the Task Bar and the system will display the 
Address maintenance tab from which you can view, add, edit, link, or delete a client’s 
Address.  
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You can toggle between the grid and card view by using the Card View option at the 
bottom. 

You can add a new address using one of the following: 

In Card View 

◼ Click in the address field under Add a new address here. 

In Grid View 

◼ Type the address details in the data entry row at the top. 

On completion of the entry, when you move away from the card or press Enter on the 
entry row, the system will ask: 

 

Click Yes and you will then be asked to select the type of address you are adding: 

 

 

Select the address type from the drop down list and click on OK. 

To remove an address, highlight the row or card and select Delete from the Task Bar. 

You can also select an existing address by using the Address Search and Maintenance 
search box and then create a link to the address. This allows you to enter an address 
once and link it to multiple client records. 

To do this, enter the search criteria that will find the address you are interested in and 
click on Search. 

 

Address Maintenance Search 

Select the address to be used and click on Link in the Task Bar. The system will display 
the Select address type dialog for you to select the type of address you are adding. This 
dialog displays the existing addresses in use by the client for information. 
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Start and end dates 

Each address has a start and end date. The start and end dates determine if an address 
is relevant to an accounting period. Hence, if the start date falls before the last day of 
the accounting period and/or the end date falls after the date the accounts are signed, 
the address will be used in the financial statements. If they fall outside of this range 
then the address will be ignored. 

The benefit of this approach is that you can have a history of different addresses and 
the system will chose the correct one for each accounting period. 

Note that for both Associations and Addresses, if you leave the start and end dates blank 
then it will be taken that the record is relevant for all accounting periods. 

Relationship mapping 

Relationship Mapping allows you to specify which associations and addresses are used for 
data presented in the financial statements. Most users will not need to access this area 
as it is a one-time setup for a practice. To access, select Maintenance Accounts 
Relationship Address Management from the main menu and the Relationship 
Address Mapping grid will be displayed. 

 

 

Relationship Address Mapping Grid 

Some relationships are fixed and at present cannot be changed, such as Has Director Of. 

The columns in this grid are as follows: 

Role Name The name of the data that is presented in the financial statements. 
This is fixed and is read only. 

Alias The code used in formats to insert the data. This is fixed and is 
read only. 

Relationship The Relationship type that is used to provide the data. For 
example, in the case of the Auditor’s name and address, this is 
picked up from the contact record that is associated by the type 
has auditor of. This is editable and when you click in a cell a drop 
down list is available for you to select from. This list includes and 
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entry of <None>. If you select this, as seen in Business Address in 
the above screen shot, then this tells the system to not look via an 
associated contact to find the address but look in the client record 
itself. 

Address type This determines the address type to use to retrieve the address to 
use. In the screen shot these are all set to Main, so the main 
address of the related contact, or the client will be used. You can 
edit this and if you click in an Address Type cell a drop down list 
will become available for you to select from. 

As an example, take the line containing the Registered Address. This indicates that the 
address of the registered office will be drawn from the contact record that is associated 
with the client via the association type Has registered office. Alternatively, you may 
wish to record the registered office as an address record in the client’s address tab. You 
can do this by changing the line to read: 

 

Providing Registered Office has been set up as an address type. From this point that is 
where the system will draw this data. However, this is a system wide setting so it should 
not be changed lightly once you have started setting up your records. 
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Working with Grids 

CCH AP makes widespread use of grids to display and for the entry of data. Grids display 
data in a tabular format and are characterised by rows and columns. This section 
summarises the basic elements of using grids within CCH AP.  

The data in grids is displayed in rows with a set number of columns containing column 
titles. If the grid is designed to allow you to make new entries, the first row of the grid 
will be a data entry row separated from existing entries by a bar. To add a new entry, 
you type the information into the cells in the data entry row. In certain circumstances, 
the system will auto populate cells with predetermined values and these can be 
accepted or changed. 

 

 

 Extract of the Receipts Grid 

Entering data in grids 

In some instances it will be possible to either type data in or select options from drop-
down lists. A common drop-down is the nominal accounts list which will be available 
wherever you need to enter a nominal accounts number.  

 

Nominal Analysis Drop-down 

For this field you can type the nominal account code, or type part of the description of 
the account to drop down a filtered list of accounts containing the string entered in the 
account name. Once the list appears, you can carry on typing to refine the filter, use 
the up and down arrow keys to select a code and press [Enter] or select an account by 
pointing to it and clicking the left mouse button. 

Some grid cells contain this small  button, which allows you to add or select more 
information. Examples of this: 

◼ Description cell of the Receipts grid. When you click on this the system 
opens a dialog that allows you to enter and see the text for very long 
descriptions. 

Grid Rows 

Column Title Cell within Column Data Entry Row Row selection column 
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Details: Name cell in the Officers grid. When you click on this the system opens the 
Find contacts dialog to allow you to search for a contact to add. 

Total line 

Where appropriate, the grid will contain a total line at the foot of the grid identified by 
the icon  . 

 

 

 Extract of View Transactions with Totals 

Shortcut menu 

You can right-click on some grids to gain quick access to common tasks via the shortcut 
menu. Some of the options available on the shortcut menu are also accessible under 
Actions on the Task Bar. 

  

Receipts Shortcut Menu 

Field chooser 

The option to Show Field Chooser allows you to select the columns that appear in the 
grid. On selecting this, the system will present a dialog that lists any available columns 
that are not currently visible in the grid. For example, for the Receipts grid there is an 
additional column that could be displayed in addition to those shown by default, called 
Account: 

 

This column displays the account to which the double entry will be posted, the Logged 
in account. If you wish to display this, point to the entry in the Field chooser and drag 
it to the position in the grid where you would like it to appear. 
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You may move any column displayed to a new position by dragging it in the column 
heading row, and remove a column by dragging it up or down off the column header 
row. Some columns are set as not been optional and you will not be able to remove 
these from the grid. 

Sort 

You can change the order by which items are displayed by clicking on the column title of 
the field on which you wish to sort. For example, if you want to sort the date by 
ascending or descending order then click the Date column title. An arrow icon appears 
in the column title indicating the selected sort order. Click the column title again to 
reverse the sorting options. 

TIP: You can use [CTRL] + left click the column title of the currently sorted column to 
return to the default sort sequence for the grid. 

Task bar options 

When a grid is displayed, two common options will normally appear in the Actions area: 

Filter 

Filters can be added to restrict the contents of the grid to only display items that match 
a specified criterion, e.g. transactions where the amount exceeds £250,000. To enter a 
filter, click the Filter: OFF option under Actions on the Task Bar. This displays the 
Filter Creation tool above the grid. You then add single or multiple conditional filters to 
apply to the grid below. 

Note: Refer to the Central Help topics for a detailed description of how to use filters. 

From the menu select HelpHelp Topics. 

Group By 

To analyse the contents of the grid by grouping, click the Group By: OFF option on the 
Task Bar. This displays the Group panel at the top of the grid and you can drag the 
column title to the group area at the top of the grid to group by that category. You can 
add sub groupings by dragging further column titles to the area. To remove a grouping, 
drag the group title back to the grid. 

Neither the filter and group settings are persistent, they are a run time setting that will 
only apply to the grid displayed. 
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Chart of Accounts 

When you create the first accounting period for a client, you select the chart of 
accounts that will be used. This chart is bound to the client and once set cannot be 
changed. As with other master pack data, the data is not copied to the client but 
records are drawn from the master as and when required. Hence, when initially viewing 
the chart from within the client data you are in effect viewing the master chart. As 
indicated below, you may customise this chart for the client, adding, editing or deleting 
accounts and sub accounts.  

To view and edit the chart, load the accounting period and select Chart of Accounts 
from the Functions area of the Task Bar. The Chart of Accounts grid will be displayed. 

 

Chart of Accounts Grid 

The default view in this grid includes the columns shown in the above screenshot; 
however, in common with most grids displayed by CCH AP you can customise the view.   

Editing the chart 

Editing the Chart of Accounts is carried out directly in the grid.  

Adding a new account 

To add a new account, click in the data entry row and type the information to be added. 
You can press Tab or Enter to move to the next cell. To commit the row press Enter in 
the last cell or press Ctrl + Enter at any time. The columns are as follows: 

Nominal code Enter the account code. The length of the code must match 
that defined for the chart selected. This will normally be 3 or 
4 characters for the main code. If you enter he wrong number 
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of characters then the system will advise you this when you 
move off the cell. 

Description Enter the name of the account. 

 

Close off account This is the account that the balance on the current account 
will be closed off to at the end of the year. Accounts in the 
profit and loss account range will normally be closed off to 
Retained Profit. Accounts in the balance sheet range will 
either be closed off to themselves or an account rolling up 
the total of a number of other accounts, such as cost brought 
forward on a fixed asset account. Details of the facilities 
available when entering an account code in a cell are 
provided in the section covering Data entry. 

Chart category The chart categories are defined in the master pack and are 
used to identify the area of the chart in which an account 
falls. This is useful where you have accounts with the same 
name appearing in multiple areas of the chart, e.g. Wages 
and Salaries in Cost of Sales, Distribution Costs, etc. You can 
either select the category from the drop down list by clicking 
on the down arrow, or start to type the name of the category 
to display a filtered list to select from. 

Quantity If the chart of accounts has had “Quantities” enabled, you 
will see a check box column in the grid.  Ticking the box will 
result in a prompt when subsequently posting a transaction to 
the nominal code to also input the quantity amount of the 
transaction. 

 

Some fields are mandatory and CCH AP will not allow you to save the new account until 
they have been completed.  

Adding Sub Accounts 

In addition to a chart having a fixed account length it will also gave a fixed length for 
sub codes. For example, the FRS102 Limited company chart has a code length of 4 and a 
sub code length of 2. For this chart wherever you type a code of 4 digits you are 
referring to the main account code and when you type a code of 6 digits you are 
referring to the sub code of an account.  

You can add sub codes to existing accounts quickly using the Chart of Accounts grid. For 
example, to create sub code 01 for code 0700 type 070001 in the Nominal Code cell of 
the data entry row. Proceed to enter the details relating to the Description, Close off 
Account and the Chart Category. 

Once you have entered the details, press [Enter] and if this is the first sub code added 
to a main account, the following confirmation message appears: 
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Click Yes to confirm the move. The system does this as once a main account has sub 
accounts you can no longer post entries to the main account, you can only post to the 
sub account codes. Hence, when you create the first sub accounts, the system needs to 
move any transactions that are currently posted to the main accounts to the first sub 
account created. 

If you are adding further sub accounts to an account that already has sub accounts, e.g. 
if you now add 070002 as a new code, this will be added without the above question 
being asked. 

The new account will appear in the grid with an icon  displayed in the Local column to 
indicate that the account has been defined at client level. 

If you type the code of an existing account in the entry line, and the details are 
retrieved but you will only be able to commit the line if you change the code. This does 
not edit the code retrieved but will create a new code with the data shown. If you have 
retrieved a line and do not want to proceed, press [ESC] twice to remove the data from 
the entry row. 

A warning message will appear if you try to create a nominal using a code that already 
exists. 

Once you have created your new sub account then it is selectable using the Close Off 
Account drop-down from the Chart grid and the Nominal Analysis drop-down in grids 
such as Payments and Receipts. 

 

Editing an Existing Account 

Locate the account that you want to modify. Under Actions on the Task Bar you can use 
the Search Code or Description field to locate the account. As you make an entry in the 
search field, the system filters the contents of the grid to display the result. Simply click 
in the column cell containing the data that you want to edit. Change the data as 
required and then press [Enter], or click away from the cell to commit the change to 

the database. The  icon appears in the Local column to indicate that the account has 
been modified for the client. 

Deleting an Existing Local Account 

You can remove local accounts provided that the account does not contain transactions. 

Local accounts are identified by this  icon, which appears in the Local column. First 
select the account, to do this, click in the left most column in the row that contains the 
account. An arrow appears in the selected column and the row is also highlighted.  
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Row Selection on the Chart of Accounts Grid 

Press the [Delete] button or select Delete from the Task Bar. CCH AP asks for 
confirmation before deleting the account.  

If the account cannot be deleted, either because it contains transactions or it is a 
master code, an appropriate message is displayed. 

Reverting to Master 

If you have edited the details of an account that was drawn from the master chart, you 
can restore the details to the defaults contained in the master by selecting the row and 
clicking on Revert to master in the Task Bar or from the popup menu. 

Under Actions on the Task Bar the following additional options are available: 

◼ Local Nominals – Filters view to display local nominals only 

◼ All Nominals – Remove filters and display all nominals 

◼ View Dimensions – Opens the Dimensions dialog for the selected nominal, see 
below. 

Dimensions  

Dimensions allow you to provide more details in financial reports by allowing posting to 
a nominal account to be sub analysed by dimensions. This can be used to provide, for 
example departmental analysis, branch or area figures, or any other common sub 
analysis that you may wish to see across a range of accounts. 

Dimensions are user definable and can be set up using the Dimensions function under 
Reference in the functions area of the Task Bar.  

These routines allow you to set up Dimensions and Dimension Members. The Dimension is 
the concept that you would like to report on and the Dimensions Members are the 
analysis of that concept. You can have any number of dimensions associated with an 
account. For example, if you have a client with 3 shops, you could set up a Dimension 
called Shop Analysis and have 3 Members; Shop 1, Shop 2 and Shop 3. 

In the chart of accounts, you can indicate which accounts you wish to analyse by Shop, 
by adding the dimension to the accounts. 

Creating Dimensions 

1. Select Dimensions under Reference on the Task Bar to open the grid. 

2. Enter the description for the dimension in the first row, Shop Analysis in our 
example and press Enter, repeat if necessary to create additional dimensions. 

3. To add the Dimension Members, select the row containing the Dimension in the 
grid and click View Options from the Task Bar. 
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4. Enter the description of the first member in the first row, Shop 1 in our example 
and press Enter. Repeat for Shop 2 and 3. A blue dot will appear by the name of 
the Dimension in the grid to indicate that members have been defined for the 
Dimension. 

 

5. Click on Close to close the dialog. 

Now that the dimension has been set up you can indicate which Nominal Accounts should 
be analysed by this dimension. 

Assigning Dimensions to Nominals  

Single Selection: 

1. Select Chart of Accounts under Reference on the Task Bar. The Chart of 
Accounts grid appears. 

2. Select the row containing the account you wish to be able to analyse and select 
View Dimensions from the Task Bar or the popup menu. The Dimensions dialog 
appears containing the dimension that you created earlier. 

Tip: Use the Search Code or Description field on the Task Bar to quickly find 
the nominal account you are looking for.  

 

3. Click in the first row and select the dimension that you want to assign to the 
account from the drop-down and press Enter. You can repeat this process to add 
further dimensions to use if appropriate. 

4. You can leave the Dimensions dialog open and select another account and 
repeat step 2 to link the dimension to further accounts. As you add dimensions 

to accounts, the  icon appears in the Dimension column of the accounts grid 
to indicate that the account has dimensions associated with it. 

5. Click Close when you have finished adding dimensions. 

Multiple Selection: 

1. To select more than one nominal to which dimensions are to be added, you can 
use the standard grid multi selection options: 

a. Select the row of the first account to be included, hold down the [Shift] 
key and select the last row. All rows will be highlighted. 
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b. You can also click with the mouse pointed to the Row Selection Column 
of the first row to include and drag the pointer to the last row to 
include. 

c. Holding the [CTRL] key while at the same time left click each nominal 
line will toggle the inclusion or removal of the line from the selected 
items.  

2. Select View Dimensions from the Task Bar or the popup menu. 

3. Select the dimension that you want to assign, as described above. 

4. Click Close. The dimensions will be assigned to the selected nominals and the  
icon will appear by the selected accounts in the grid. 

Nominal roles 

Nominal roles allow you to specify which accounts will be used for predefined actions 
carried out by the system. For example, when the system rounds the trial balance it may 
not balance due to rounding differences. The system corrects this by adjusting nominal 
accounts in the profit and loss and balance sheet areas to ensure that the rounded profit 
figure is correct and the balance sheet balances. The accounts that will be adjusted are 
shown by the associated role in the Nominal Role dialog. 

To view the Nominal Role dialog, select Rounding and Suspense from the Actions panel 
of the Chart of Accounts task bar: 

 

 

 

The dialog contains a list of all predefined roles and the nominal accounts assigned to 
each. To change the nominal account in use, click in the appropriate line in the Nominal 
Code column and enter the new account to use. 

If you need to reset the Nominal Roles to the default values, you can do this by clicking 
the Reset to Default button. 
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Data Entry 

Editing an Existing Transaction 

Click in the cell on the grid that you want to modify and then make the necessary 
changes. If the cursor icon does not appear within the selected cell then you cannot edit 
it. 

Cancelling out of a Transaction 

If you are mid-way through inputting a transaction, you cannot close or navigate to a 
different area within CCH AP without finalising the transaction first.  If you want to 
cancel the current entry, press the [ESC] key twice to clear the transaction.  You can 
then close the current view. 

Receipts and Payments 

The entry of Receipts and Payments are similar and are described in this section.  

1. Select the accounts production client that you want to add payments or receipts 
for. 

Note: See Client Management for further information on selecting or creating a 
client. 

2. Click the Accounts Production tab and then double-click the account period 
that you want to work on.  

3. Click the Receipts or Payments option on the Task Bar to open the data entry 
grid. 

4. The Logged In Account (required) is shown at the top and shows the account 
that CCH AP will use to debit the transaction for receipts or credit for payments, 
i.e. the account to which the system will complete the double entry. 

5. Click in the entry row at the top of the grid above the dividing bar, or press 
[Enter] if the row is highlighted. Complete the fields in the row, clicking on 
[Enter] or [Tab] to move from column to column. Note that the Date and 
Nominal Analysis fields are mandatory. The fields are as follows: 

◼ Date: Enter the date, or this can be left blank if you want the date to 
default to the period end date. You may type the date with or without 
separators, e.g. you can type 010911 or 01/09/11 or you can use the drop 
down to select the date from the calendar.  

◼ Batch Ref: Add a reference number or other relevant information. Entry 
can be alphanumeric.  

◼ Description: Describe of the transaction. 

◼ Nominal Analysis: Type or select the nominal account that you want to 
post the entry to. Note that you can type the nominal account code, or 
type part of the description of the account to drop down a filtered list of 
accounts containing the string entered in the account name. Once the list 
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appears, you can carry on typing to refine the filter, use the up and down 
arrow keys to select a code and press [Enter] or select an account by 
pointing to it and clicking the left mouse button. 

If the account to which you wish to post the item is not in the chart, you 
may create a new account by pressing [F10]. See below. 

◼ Amount: Enter the monetary value. 

6. To save the transaction press [Enter] or [TAB] off the last field on the grid. The 
transaction will be committed to the database and will appear in the grid below 
the entry line. Posting is real time so the Trial Balance totals are updates as 
each line is committed. 

Notes:  

At any point while entering a new transaction you can press [Ctrl] + [Enter] to commit 
the transaction. 

If you have started to enter data and wish to abort the entry, press [Esc] twice. 

When you commit a transaction, a warning message appears when you have not 
completed all fields required. Correct the error and then save the transaction with 
[Ctrl] + [Enter].   

If you have set up multiple reporting periods, as described later in this document, the 
Reporting Periods drop-down is visible when more than one reporting period is in use. 

Data Entry Aids 

In the “Repeat” Group on the Ribbon, (or under Actions on the Task Bar) there are a 
number of data entry options that are provided to speed up date entry. The options 
available vary from screen to screen. 

 

Receipt and Payment Data Entry Aids  

Click each option on the ribbon to set the repeats appropriate to the data you are 
entering. These settings persist from one data entry run to the next and can be changed 
at any time. 

Task Bar Options 

The options covered here are also available on numerous other functions and will 
operate as described below. 
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Print 

This option allows you to print the current contents of the grid displayed. On selecting 
the option, the Print dialog appears from where you can print or preview the 
transactions using the default settings. Advanced options are accessible via the Options 
button. These allow you to change the heading, footer and set various other print 
options as well as change the column widths. 

Export to Excel 

Select the option Export to Excel from the Task Bar to create a worksheet in Excel 
containing the information currently displayed in the grid. This feature supports MS 
Excel 2007, 2010, 2013. 

Show shortcut keys 

There are a number of shortcut keys that are available to you when working in grids. To 
see the list of these select Show shortcut keys from the Task Bar. 

 

Show Field Chooser 

The Show Field Chooser option displays the Field Chooser dialog, which allows you to 
add or remove columns from a grid using drag and drop. See Customising Grids for 
further details on adding and removing columns. 

Filter 

Filters can be added to restrict the contents of the grid to only display items that match 
a specified criterion, e.g. transactions where the amount exceeds £250,000. To enter a 
filter, click the Filter: OFF option under Actions on the Task Bar. This displays the 
Filter Creation tool above the grid. You then add single or multiple conditional filters to 
apply to the grid below. 

Note: Refer to the Central Help topics for a detailed description of how to use filters. 
From the menu select HelpHelp Topics. 
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Group By 

To analyse the contents of the grid by grouping, click the Group By: OFF option on the 
Task Bar. This displays the Group panel at the top of the grid and you can drag the 
column title to the group area at the top of the grid to group by that category. You can 
add sub groupings by dragging further column titles to the area. To remove a grouping, 
drag the group title back to the grid. 

Neither the filter and group settings are persistent, they are a run time setting that will 
only apply to the grid displayed. 

Sort 

You can change the order by which items are displayed by clicking on the column title of 
the field on which you wish to sort. For example, if you want to sort the date by 
ascending or descending order then click the Date column title. An arrow icon appears 
in the column title indicating the selected sort order. Click the column title again to 
reverse the sorting options. 

TIP: You can use [CTRL] + left click the column title of the currently sorted column to 
return to the default sort sequence for the grid. 

Changing the Order of Columns 

You can change the order of columns by positioning the mouse pointer over a column 
title and dragging the column left or right with the left mouse button pressed. When the 
column is positioned in a drop area, a red arrow appears indicating where the new 
column will rest when you release the mouse button. 

Removing or Adding Columns 

You can remove columns form the grid and add columns if all available columns are not 
shown. To do this, position the mouse pointer in the grid, right-click and then select 
Show Field Chooser from the shortcut menu. The Field chooser dialog opens. 

 

Field Chooser View Transactions Hidden Columns  

To remove a column, position the mouse pointer over the column title and drag it to the 
Field Chooser dialog with the left mouse button pressed. Release the button and it will 
appear in the list in the Field Chooser. 

To add a column, drag the name of the column to the column title row in the position 
where you want it to appear. 
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Adding Columns to a Grid 

Entering Journal Data 

The entering of data for journals is similar to that for receipts and payments, but there 
is no concept of a Logged in Account, however there is a concept of a batch reference 
and date for the journal batch being entered. In all other respects you enter journals as 
described for payments and receipts.  

Note: See the Adding Payments or Receipts section for further information on entering 
transactions. 

To display the journals grid, select the Journals option on the CCH AP Task Bar under 
Transactions. 

To Add a Journal Item 

1. Enter the Batch Reference number e.g. A123 Batch 1. This is optional and will 
appear against the journals lines entered when they are viewed elsewhere, e.g. 
in the nominal ledger.  

2. Select one of the following options from the Type drop-down: 

◼ Journal (default) 

◼ Opening Balance 

◼ Restatement 

◼ Reversing 

3. Select the appropriate Date and Reporting Period if required. 

4. Enter the journal lines. There is no restrictions on the number of lines that can 
be entered in a journal batch. 

As you enter each journal line, the amount by which the journal batch is out of balance 
is shown in the total field at the foot of the grid (indicated by this icon ). You will not 
be able to Post the Journal entries until it is balanced and the total field displays zero. 
You can, however leave a journal batch unposted by saving the batch. The system will 
retain the entries as draft journals and provide a visual indication of this by showing the 
Journal Task Bar option in bold with the number of entries in (). 

Note: The Reporting Period drop-down is only visible if you have several reporting 
periods in use. 
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Using Debits and Credits Mode 

The Dr/Cr mode option provides you with alternative ways of entering the amount of 
each journal line.  

 

Dr/Cr mode on the Journal Ribbon Bar 

When OFF, the system displays a single column for the amount and you enter debits 
unsigned and credits as negative values. When ON, two value columns are shown, one 
for Debit and one for Credit. In this mode you enter all figures unsigned in the 
appropriate column to indicate if the amount is a debit or a credit. 

The option Dr/Cr mode is a toggle, so clicking on it toggles the view on and off. 

New Row Position 

When entering a series of journals, you can control if the most recent line appears at 
the top or the bottom of the grid.  This preference can be set per user by clicking the 
New row position button on the ribbon. 

Journal Types 

There are 4 journal types recognised by the system: 

Journals 

Standard journal entries to debit or credit accounts in the accounting period. 

Opening balances 

Entries of this type are normally automatically generated by the system when you carry 
out a year end procedures to balance forward to the new accounting period. The system 
creates the opening balance journals required to record balance brought forward from 
the previous accounting period. 

You may also use this routine to enter opening balances if this is the first accounting 
period you are processing for the client. 

Restatement 

The system draws the comparative TB data from the prior accounting period, 
comparative figures are not held in the current accounting period. However, there are 
occasions where you need to restate comparatives. This journal entry type allows you to 
enter journals that will adjust the comparative data shown for the accounting period in 
which the journals are processed. They do not affect the current period’s balances in 
the accounting period’s trial balance.  

The benefit of having this entry type is that you can adjust the comparative data 
without changing the actual TB recorded in the prior accounting period. 
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Reversing 

This journal type allows you to enter transactions that will be reversed in the next 
accounting period, e.g. an accrual or prepayment.  

Entries in the next period reversing the journals made using this type will automatically 
be generated when you close a reporting period or carry out a year end balance 
forward. 

Viewing Transactions  

To view the transactions, load the accounting period and select View Transactions from 
the Functions area of the Task Bar. A grid containing a list of the transactions entered 
for the period will be displayed. 

The grid contains an “ID” field which can be used to uniquely identify each transaction 
and assist in sorting the data in the grid. 

You may select the Debit/Credit Mode option to alter the column layout to your 
preference. 

Editing a transaction 

You can edit any of the information displayed, apart from the entry type. To do this, 
click on the data to be changed in the transaction line and the cell will become 
editable. Any changes that you make are committed to the database as soon as you 
move focus away from the cell.  

If you edit the amount of a journal entry, the imbalance created will be displayed in the 
total bar at the foot of the grid. The system will not allow you to close the transactions 
window, the client, or Central, until you have corrected the imbalance changing the 
amount of further transactions until the imbalance if shown as zero. 

All changes made to the transactions listed will be recorded in the audit trail. 

Sort, filter and group transactions 

You can sort, filter and group the transactions listed. Please refer to Working with grids 
for more information. 

List report 

A Smart Report is provided that generates a formatted report of the transactions listed. 
Select List Report from the Actions list to produce this report. 

Export to Excel 

Using the option Export to Excel form the Actions list allows you to export the list of 
transactions displayed to Excel. On selecting this option, the system will open Excel and 
display the exported transactions. 

Audit trail 

The system maintains an audit trail of all transactions entered and all amendments 
made to them. A quick link is provided in the Actions list of the View Truncations 
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screen to allow you to display the audit trail. Select Audit Trail – All Transactions from 
the Actions list and the following dialog will be displayed: 

 

 

This will contain a list of the history of transaction entry and edit. You can sort the list 
by clicking in the column headings and when you select an entry in the list the details of 
the change will be shown in the Before and After grids. 

It is also possible to obtain access to the full list of audit trail entries, including details 
of changes in Central and other products, via Maintenanace  Audit trail View Audit 
Trail.  

Import 

CCH AP includes the ability to import trial balances and transactions from delimited 
files. CCH AP provides a set of default file structures which represent commonly 
occurring data fields.  To use the import options you can use one of the default file 
structures, or setup your own structure relating to the file to import and optionally a 
nominal mapping so that CCH AP understands how to import the data. 

Data may also be imported into a travelled database using the same method. 

The Mapping and File Structure areas are contained within the Maintenance menu and 
allow you to save the mappings once created.  

Nominal mappings - Maintenance Menu 

To specify the details of how imported nominal codes are mapped to CCH AP codes, 
select MaintenanceAccountsImport TBNominal Mapping from the menu and the 
Import TB Nominal Mappings tab will be displayed. 
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This allows you to create new and also to edit existing mapping files. 

New system nominal mapping 

Ensure that the Create Mapping File radio button is selected and select the Entity, 
Chart and Master Pack version for which the mapping is being created. You can either 
create the mapping file from scratch, manually entering the information relating to the 
External Code, optional External Name and the CCH Account Code it is to be mapped 
to, or you can import the data for the first 2, or all 3 columns from a text file. 

Manual entry 

For manual entry, you do not need to enter anything in the Import File Name or 
Formatting fields. Click in the entry line and enter the information for the each line, as 
follows: 

External Code The code of the nominal account in the system to be imported 
from. 

External Name  The name of the account as entered in the system to be 
imported from. 

Account Code The CCH nominal account code that transaction bearing the 
external code should be posted to in CCH AP. 

Import 

To import a mapping file, enter the Import File Name, or use the [Browse] button to 
select it, set the format of the file being imported, e.g. Comma Separated, and click 
[Import]. The file will be imported and the information presented in the grid in the 
lower half of the screen.  

If the checkbox Import AP Code is not ticked, the first 2 columns will be populated with 
the first 2 field on each line of the import file, which must contain the code from the 
third party system and the account description. If the checkbox is ticked, the system 
will also import the 3rd field and insert it in the Account Code column. 

After import, you can edit the data presented in the grid, completing, or changing, the 
Account Code being mapped to. 

If you have previously created a System mapping file and you wish to edit it select the 
Edit System Mapping File radio button, select the Mapping Name and then amend the 
mapping as per above. 

If you have previously created a Client Mapping file and you wish to edit it select Edit 
Client Mapping File, amend the file as required and then save the changes you have 
made.  If you wish to promote your changes to a system mapping then select the 
Promote to system mapping file button. 

Saving the nominal mapping data 

After you have defined the mappings, enter a unique Mapping Name to identify the 

mapping file and click [Save]. Note: You are prevented from saving with a system 
mapping name that already exists. 
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Import/Export file structure 

To define the format of files that you wish to import, or generate on an export, select 
MaintenanceAccountsImport/Export DefinitionFile Structure from the menu and 
the File Structure tab will be displayed; 

 

 

This allows you to create new and also to edit file structure definitions. 

Create a new structure 

Ensure that the Create Mapping Structure radio button is selected and select the 
structure type to be created. You can view a file to determine its structure while 
entering the definition. To do this, enter the name of the file to view in the File Name 

field, or select it using the [Browse] button and click on . 

To create a structure, you first define the format of the file and then the fields to be 
imported from it. 

Separator Enter the formatting details for the file, selecting from Comma 
Separated, Line feed separated or User defined. For user defined, 
enter the separator used in the file, e.g. “;”. 

Has Headers If the file that will be imported using the definition has header 
information that should be ignored, tick this checkbox and enter the 
number of lines that should be ignored. 

Number of 
fields 

Select the number of fields in each record using the scroll buttons. 
Fields are read in order so if there are any field that you wish to skip 
in the file they should be included in the number entered here and 
they can be mapped to <None>. On entering the number of fields, 
the system will display a grid in the lower half of the screen 
representing the number of fields to be mapped. 

Mapping 
Structure 
Name 

Enter the unique name which you wish to use to identify the file 
structure.  

Mapping 
structure 
type 

Select the required mapping structure for the type of file you are 
importing (trial balance, payments / receipts, journals), this will be 
defined by the contents of your import file 

Map fields 

 

Against each field position, Column1 to ColumnN in the grid, select 
the CCH AP field that the data is to be posted to. To do this, click in 
the PA Field Name column and select the field form the dropdown 
list. 
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Delete csv 
file after 
successful 
import 

If ticked, AP will automaticaly delete the CSV file after completing 
the import.  

Verify that 
Import file 
name 
matches 
Client Code 

If ticked, AP will check before importing that the csv filename is an 
exact match for the current Central Client Code.  If it is not, the 
import will be stopped.  

 

After you have completed the definition click [Save].  

Editing structure 

To edit an existing structure definition, select the Edit Mapping Structure radio button 
and a drop down arrow will appear at the end of the Mapping Structure Name field. 
Select the name of the definition to edit and it will be loaded and presented in the grid. 
You may edit any of the information displayed in the grid and add new line to the 
definition. After making the changes, click on the [Save] button. 

CCH AP provides 6 default structures for importing Trial Balance data; 

 

And 1 default structure for importing Transactions; 

 

In practice, getting the transaction data into this format can be difficult. The problem is 
that the nominal code should be in one of two columns. A simpler approach that works is 
to always put the nominal code in “Nominal Code Dr” and to set the Amount as negative 
when it is a credit. 
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Importing data 

To import trial balances select Import from the CCH AP Task Bar: 

 

Import Data Window 

Importing a trial balance 

Select the source of the data you wish to import, either “From CSV File” or “From 
Software”.  Currently CCH AP supports importing directly from two third party 
bookkeeping systems, QuickBooks and Xero.  Further systems will be added in future 
updates. 

Select Trial Balance from the drop down list, the name of the Mapping to use and the 
name of the Structure that relates to the file to be imported (these will be set by 
default if you are importing From Software). 

If importing from CSV File, select the file containing the trial balance to import using 

the  button. 

Then click the Preview button to load the data. 

If importing From Software, at this point you will be prompted to enter your credentials 
for the bookkeeping system.  CCH AP will securely store your credentials for future use. 

Pick the required organisation. 

CCH AP will then display a confirmation screen to highlight the details of the client in 
CCH AP and the organisation selected from the bookkeeping system.  This is a safeguard 
to reduce the risk of selecting the wrong organisation. 

The data will then be displayed in the grid, showing: 

From The nominal codes from the system being imported from. 

To The CCH AP nominal account that the balance will be posted 
to. 

N columns The remaining data that will be posted to the fields shown in 
the column headings. 

If there are any header rows in the csv file that need to be ignored, you can mark these 
by ticking the “Has headers” checkbox and then entering the number of rows to be 
skipped. 
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If there are any nominal codes in the file to be imported that are not included in the 
mapping file, they will be shown in the grid but the To field will be blank. You can 
restrict the grid to only show these unmapped lines using the checkbox Show Unmapped 
Only. You can enter the missing codes by typing directly into the grid. 

Once you have reviewed the contents of the grid, and provided any missing codes, click 
on [Import] to import the data. The system will reverse the current balances in the trial 
balance and generate a journal batch posting the imported balances. Provided the 
imported data balances it will be posted into the system, otherwise you will receive a 
message that the data does not balance and the batch will be left unposted so that you 
can load and correct it before it is committed. 

Errors in the import file 

If there is an error in the import file then a window will open after selecting the import 
button, this includes a hyperlink in the final column which will highlight the error in the 
grid containing the data enabling you to easily adjust the data. 

 

Importing transactions 

The process for importing transactions is exactly the same as described for importing a 
trial balance but with Import type set to Transactions. In this case, the current trial 
balance is not reversed but the transactions imported will be appended to the existing 
transactions in the system. 

Nominal Debit From The nominal debit codes from the system being imported from. 

Nominal Debit To The CCH AP nominal debit account that the balance will be 
posted to. 

Nominal Credit 
From 

The nominal credit codes from the system being imported 
from. 

Nominal Credit To The CCH AP nominal credit account that the balance will be 
posted to. 

N columns The remaining data that will be posted to the fields shown in 
the column headings. 
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Importing Ledger transactions from CCH Accounts Production (VAP) 

Sites who continue to use CCH Accounts Production (VAP) for recording sales and 
purchase ledger transactions may import that data into AP for the purpose of generating 
year end statutory accounts. 

A Configuration Key enables this option, which can be entered in Maintenance > User 
Defined > Configuration; 

VAPBookkeeping with a Value = 1 

This will then expose a third Import mode; 

 

Full instructions on how to use this mode are available in the CCH AP 2014.3 Release 
Notes. 

Export 

To export transactions or trial balances select Export from the CCH AP Task Bar: 

 

Select the Export Type; either Transactions or Trial Balance. 

Select the structure of the file to be exported from the drop down list. For a structure 
to be appropriate it must contain the CCH AP field Nominal code. If it does not contain 
this a message will be displayed and you will not be able to proceed. 

Click in the filed File to Export and the Windows Save file as dialog will be displayed. 
Browse to the path where the file is to be saved and enter the name to be used.  

Finally, click [Export] to export the data. 

You can also export the Trial Balance in a single action directly from the Trial Balance 
screen using the Export for Support button on the ribbon: 
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Tax Link 

If you also use CCH Personal Tax or CCH Corporation Tax, you can easily share data with 
those applications to avoid the need for rekeying. 

Click the Tax Link option on the CCH AP Task Bar. 

The screen then shows a number of tax related balances, which you can edit 
disallowable totals for. 

You may use the Range Contents task to identify which nominal codes are making up the 
range balances displayed. 

To share that disallowable data with Tax, simply click Update Tax; 

 

You may also configure CCH Central to automatically share this data with tax.  Any time 
a journal is input or edited within Accounts Production, the system will detect this and 
automatically share the latest balances with tax.  This may be enabled by setting up a 
Configuration Key in Maintenance > User Defined > Configuration.  The key is 
AccountsUpdateTaxLink, with a value = 1. 

 

Depending on the configuration choices made in Tax, this will either update the relevant 
Tax Return automatically, or store the data in a ‘waiting room’ until the Tax user 
decides to update the Tax Return manually. 
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Trial Balance 

To view the Trial Balance, select Trial Balance from the CCH AP Task Bar and the Trial 
Balance grid appears. 

By default the trial balance will only contain accounts that have a balance to report in 
either the current or prior year. If you would also like to include accounts where there 
are transactions but the resulting balance is zero, tick the checkbox Include Zero 
Balances in the Actions panel. 

If you have selected Enable Quantities on the Chart of Accounts screen, you can display 
the Quantity balance of each nominal code by ticking the Include Quantities option in 
the Actions panel. 

Printing reports 

You can produce a printable report of the trial balance using Print Trial Balance from 
the Actions panel. This will result in a print preview of a Smart Report that can be 
printed or exported to Excel. 

A printable nominal ledger is also available using Smart Reports including some or all 
accounts. To include all accounts, click the checkbox in the heading of the first column 
of the grid. To only include selected accounts, tick the checkbox for each account to 
include. Finally select Print Nominal Ledger to generate the report. 

Viewing Nominal Details 

You can view the transactions associated with a particular nominal code. To do this, 
click the code shown as a hyperlink in the Nominal column and a dialog will be opened 
displaying the transactions for the selected nominal account.  

 

 

To display the details of another nominal, select the nominal code on the Trial Balance 
grid. This updates the transactions displayed in the open dialog with those associated 
with the selected nominal code.  

Nominal Code 001 

Details 

Click another Nominal 
Code to view details 

instantly 
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By default the transactions shown on the Nominal grid are read-only. However, you can 
tick the Edit Transactions checkbox to switch to edit mode. In this mode, the 
transactions are displayed in a different format and any field that cannot be edited is 
shaded. You can click into any cell that is not shaded and edit the information recorded.  

If you wish to change any of the shaded data, e.g. the amount of journal entries, you 
can click the hyperlink on the ID column to jump to the View Transactions screen. 

Filter Trial Balance 

You can filter the transactions that are included to arrive at the trial balance displayed 
using the option Filter Trial Balance from the Actions panel. On selecting this, the 
following dialog will be displayed. 

 

The top panel contains any reporting periods that have been defined for the client and 
the lower panel any dimensions that have been set up. When you initially display a TB 
all periods and dimensions are included giving the year to date TB for the whole 
company. However, you can change this by removing ticks to restrict the figures to that 
require, e.g. a single period for 1 department. Click on [Filter] and the filter will be 
applied. Once the required figures are shown you can close the filter dialog. 

The “None” option allows you to identify any balances that were not assigned to any 
dimension during transaction entry.  These are potential oversights that can 
subsequently be corrected as necessary. 

Note that when you filter by dimensions it is possible that the filtered TB will not 
balance. This is not an error as we do not enforce double entry within dimensions. 
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Save Trial Balance 

The Saved Trial Balance option under Actions on the Task Bar allows you to save the 
currently displayed Trial Balance. This could be the default year to date TB or a filtered 
TB.  

When you click the Saved Trial Balance option the Save Trial Balance dialog appears: 

 

Enter a name to identify the trail balance and enter the User defined reference by 
which you wish to refer to this trail balance data in reports. The reference entered here 
can be used in formula in financial reporting to pick up the balances for inclusion in 
reports. References A to F are reserved, but other than that you are free to use 
references of your choice. In this release references are restricted to a single character. 
E.g. you could use “M” to represent the current months figures. You can use the drop 
down to see a list of any existing references in use. If you enter a reference that is 
currently associated with another source will advised of this and offered the option to 
continue, for example: 

 

In this example, you could define a report using “M” in the formulas and produce it each 
period, after the period’s TB had been saved, to show the current periods figures. 

Viewing Saved Trial Balances 

To view a list of saved trial balances, click the Saved Trial Balance option on the CCH 
AP Task Bar. The system will display the first trial balance in the list. To switch to view 
another Trial Balance, select the name of the trail balance from the Saved Trial 
Balance drop-down in the Actions panel.  

 

The drop down list also shows the User defined reference allocated to each saved trail 
balance. 

To maintain the list of saved trial balances and their associated UDRs, click the Edit 
task;  
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This displays the Saved Trial balance Maintenance screen; 

 

You can display the User Defined References allocated in other accounting periods for 
the Client by using the “Current” and “All” radio buttons. 

Deleting a Trial Balance  

From the Saved Trial Balance Maintenance screen, use the Row Selection Column to 
select the trial balance that you want to delete and press the <Delete> key. The system 
will ask you to confirm that you wish to remove the trial balance before carrying out 
your instruction. 

 

Saved Trial Balance Row Selection 

Repeat the process if you have more than one trial balance saved. Finally, click on [OK] 
to close the dialog. 
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Advisor Journals 

To create audit journals, select Create Advisor Journals from the CCH AP Task Bar and 
the Create Advisor Journals grid will appear. 

 

Entering advisor journals follows a similar process to entering normal journals, however 
for advisor journals you can save any number of batches of unposted journals which will 
be considered potential journals not yet agreed with the client. 

To Create an Advisor Journal 

Enter the optional Batch Reference e.g. A123 Batch 1. This reference will be associated 
with all entries made in the batch.  

Select the type of the adjustment being entered form the Type drop-down: 

◼ Adjusting 

◼ Group Elimination 

◼ Potential 

◼ Reclassification 

Enter the journal batch lines as appropriate. Note that, as with journals, you can toggle 
between entering amounts as positive for debits and negative for credits, or using a 
debit/credit column format. 

The system will not allow you to post or save the entries until the batch balances. 

Potential journals 

If the batch of journals are potential entries that have not yet been agreed with the 
client, click on [Save] to save the batch. Note that you cannot save some entries in a 
batch but leave others unposted so ensure that each batch represents entries that will 
be approved as a single concept. Unposted entries will have no effect on the balances in 
the trial balance. 

Agreed journals 

If the journals being entered are agreed, then click [Post] to commit the batch. Once 
you post advisor journals they will appear in the View Transactions grid and update the 
Trial Balance. 

Viewing Potential Advisor Journals 
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To view Potential Advisor Journals, select View Advisor Journals on the CCH AP Task 
Bar.  A grid appears showing any potential advisor journals for the dataset. 

 

 

You cannot edit entries directly on this grid, to edit entries click on the Edit hyperlink. 
This opens the batch in a separate tab to allow you to edit or add to the batch. You can 
edit any of the information shown and add new lines. 

To post a batch, click on the Post hyperlink. 

Viewing Posted Advisor Journals 

To view posted Advisor Journals, select View Advisor Journals on the CCH AP Task Bar.  
A grid appears showing any posted advisor journals for the dataset. Click the Posted 
button on the ribbon to see all posted Advisor Journal batches.  

 

This grid is laid out in the same way as the potential journals grid, however the Post 
hyperlink becomes an Unpost option. Select this to reverse the posting of any advisor 
journals posted in error. 

 

There are four Smart Reports that can be run to present information about the Advisor 
Journals; 

◼ Adjusting Journals Report 

◼ Reclassification Report 

◼ Potential Journals Report 

◼ Advisor Details Report 

These are accessed from the View Advisor Journals window. 

The Adjusting Journals Report reconciles the Results as per draft accounts to the Results 
as per the financial statements. 

The Reclassification Journals Report is a report to show any journals made to re-analyse 
or reclassify items.  

The Potential Journals Report shows the potential adjustments to the Results as per the 
financial statements. 
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The Advisor Details Report is a summary report showing all Advisor Journals of all types. 
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Year End 

The Year End performs a balance forward of financial data to the next accounting 
period. Select the client to be balanced forward click the Accounts Production tab and 
load the latest accounting period.  

The Year End option appears in the Actions panel of the Accounts Production Home 
Page. Note that this option will only be enabled if you have the latest accounting period 
open and, if there is more than one reporting period, you are in the last reporting 
period. Refer to Reporting Periods for more information. Select the Year End option and 
the Year End Wizard dialog will appear: 

 

Year End Wizard Dialog 

Zero trial balance 

If this radio button is set to Yes then CCH Accounts Production sets the balance on all 
accounts to zero in the new accounting period created on the balance forward. If it is 
set to No, then balances on accounts will be carried forward accordance with the close 
off settings on each account, producing the Opening TB in the new accounting period. 
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FRS102, FRS105 and IFRS 

Limited company and LLP clients will be required to adopt the FRS102, FRS105 or IFRS 
accounting standards or related SORPs.  This process is facilitated during the year end 
routine.  Please see the CCH AP 2015.2 Release Notes for full details. 

 

Workflow 

If you are using CCH Workflow, then the Year End wizard will allow you to select a 
workflow template to attach to the new accounting period. 

 

Following the year end, the list of accounting periods shown in the client’s Accounts 
Production tab will be updated to reflect the new accounting period created. You can 
open it by selecting it from the list, or switching the open accounting period to the new 
one using the drop down list above the Actions panel when the Home Page is displayed. 

 

 

Note: If you have entered reversing journals, they will be automatically reversed in the 
new accounting periods after the balance forward, 
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Finalise  

Finalise indicates to the system that the accounts for the accounting period have been 
finished and approved and that no further changes are allowed. To finalise the 

accounting period, click the Home  icon on the Task Bar and then select Finalise 
Accounts.  

You can also simultaneously commence the Year End process by selecting the Finalise 
Accounts & Year End. 

 

 

Note that where you have multiple reporting periods the option to finalise the accounts 
will only be available if you have closed off earlier reporting periods and you are 
processing the final reporting period. See Reporting Periods for more information. 

 

Finalising an accounting period places it into “read only” mode.  You will not be able to 
edit transactions, statutory database or formats once the accounting period has been 
finalised.  It is possible to un-finalise the accounting period by using the “Undo Finalise 
Accounts” task (this is controlled by a task permission #client #can undo finalise 
accounts); 

 

 

Please note that amenments made to the master pack via the Maintenance > 
Accounts menus can potentially impact a finalised accounting period.  

For this reason, Wolters Kluwer recommend that you generate a PDF set of accounts 
when finalising in order to guarantee you have the ability to reprint an exact replica of 
the accounts as they were when finalised. 
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Statutory Database 

The Statutory Database allows you to select and maintain the non-trial balance based 
information that appears in the Final Accounts. To display the statutory database select 
Statutory Database under Financial Reporting on the CCH AP Task Bar. 

The Statutory Database is presented in a “tree” structure; the tree consists of a number 
of folders each containing a number of nodes, which may themselves have sub nodes.   

Each node has an icon to identify the type of data it contains. A node may also be 
identified with a red or blue icon.  A red icon indicates that the disclosure is not 
required for the organisation being processed and a blue icon that the disclosure is 
optional. 

The icons used are as follows: 

 
Node containing multiple fields of data or 
a data entry grid 

 Paragraph node 

 
Flag – can be Yes, No or Not Applicable 

 
Date node 

 
Fixed grid node 

To expand a folder, click on the “+” symbol to the left of the node, click on the “-“ 
symbol to collapse it.  To collapse all nodes, select Collapse Tree on the Action panel. 

When you select a node, the area to the right of the tree displays the data held in the 
node.   

Multiple field nodes 

When you select a multiple field node, you will either be presented with multiple fields 
or a data entry grid. 
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General information - example of a multiple field node 

 

You cannot edit shaded fields, however all other fields can be edited. The shaded fields 
will either be auto generated or relate to prior year’s data which will be drawn from the 
previous accounting period. If you wish to change the prior year’s data, load the 
previous year’s data set and edit it there. 
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Subsidiary undertaking – example of a data entry grid node 

Data entry grids work in exactly the same way as other data entry grids in the system. 

Paragraph nodes 

When a client is created, some paragraph nodes will be populated with default wording 
based on a set of standard paragraphs defined for the entity type. For a Paragraph node 
type, the system displays the current text relating to the paragraph in the Node details 
area. To edit a paragraph, click the Edit button. In addition, you can use the drop-down 
list under Node Details to select the wording from a different standard paragraph.  To 
remove the selected text, click the Clear button. If you see [Customised] in the drop 
down field, this indicates that the text in the paragraph has been edited for the client. 

  

 

 

When editing a paragraph node, it is possible to paste in text copied from a MS Word 
file.  Sometimes the source text can contain hidden Rich Text formatting, and this can 
have an unintended influence on how that paragraph is rendered on the face of the 
accounts.  To control this, AP will default to “paste plain text” whenever you paste into 
the paragraph.  This removes any hidden RTF code and improves the consistency of the 
rendered accounts. 
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Flag node 

Flag nodes contain a description and either a checkbox if there response required is to 
toggle something on or off, or radio buttons for Yes, No or N/A: 

 

Date node 

A date node contains a description and an edit field for the date. 

 

You can use the drop down arrow to display a calendar from which you can select a 
date, or you can type the date into the edit box.  

Fixed grid node 

A fixed grid node allows you to enter data into a grid: 

 

The cell that has focus is surrounded by a double border. Enter the data and press 
<Enter> to move to the next editable cell. You can also use the arrow keys to move 
from cell to cell but note that not all cells will be editble. 

Statutory Database Search 

There is a powerful search function to help you locate the node you require.  Simply 
type a key word in the Search field on the Task Bar and press Enter.  The first node that 
matches your criteria is highlighted. You can then press [F3] to skip to the next node 
that matches your search criteria. To display all nodes again, clear the value from the 
Search field. 
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It is also possible to search for the code of the database field in which the disclosure is 
stored.  For example searching for “#cd80” will position the cursor to select 
“Depreciation – Investment properties”. 

Alternatively, you may search for a key word and use the Previous and Next search 
arrows to jump to the previous/next matching node; 

 

View Custom Paragraphs 

You can filter the statutory database tree so that it only displays paragraphs that have 
been customised for the dataset. To do this, click the Custom Paragraph Nodes check 
box on the Task Bar. Click the check box again to remove the filter. 

 

Custom Paragraph Filter Option 

 

General Information 

The General Information node allows you to view and modify company details, including 
date settings and rounding units. Select General Information under the General folder 
to display the selected company details. These details appear under Node Details in the 
right pane: 

 

 

 

 

 

General Information Node 

Size and Audit 

This grid is available for some entities and provides guidance information on the size of 
the entity relative to Companies Act thresholds, as well as guidance on the Audit 
requirement: 

Click nodes to display details 

Click to expand  

Click to collapse 
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Disclosure Information Node Details 

 

CCH AP populates some of the information shown e.g. some details are populated based 
on the company type and business size.  The system will calculate the company size and 
audit required based on information obtained from the current, comparative and pre-
comparative accounting periods.  The guidance is highlighted in the red-bordered cells. 

 

 

You must make the final selection of the size and audit requirement using separate 
question nodes in the Client Preferences section of the tree: 
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CCH Working Paper Management 

If the accounting period has activated Working Papers, then the Statutory Database will 
also display within the tree any working papers that are present. 

The tree can be filtered using the options at the top as follows: 

 

 

All – displays all statutory database nodes and all working papers 

Disclosures - hides the working papers and only displays the statutory database nodes 

Working Papers – hides the statutory database nodes and only displays the working 
papers
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Officers 
All clients and contacts are maintained in the Central database, hence to disclose an 
officer in CCH AP you first need to set the individual up as a contact or client in Central. 
Once they are present in the database, you can either set the association in Central, to 
say indicate that the contact is a director of a company, or set the association via the 
accounting period in CCH AP. If you set the association in Central, the officer will 
automatically appear in the Officers grid, provided the start and end dates for the 
association indicate that the contact was an officer during the accounting period. 

To maintain officers’ details in CCH AP, select Officers from the Financial Reporting 
group on the CCH AP Task Bar. This displays a grid showing the contacts that are 
associated as officers. 

 

To add a new Officer, click in the first row of the grid in the Name column. Click the 
button in the Name field to search for the required contact. Once you have located the 
contact, either double click on the line containing the contact, or select it and click on 
OK. 

The remaining columns contain dat that is required for disclosure in respect of the 
officer. 

If the there is no secretary, select the checkbox at the top of the window, otherwise you 
can select the Secretary at the top of the window by clicking the ellipsis button in the 
Secretary field. 

Checkboxes are available for you to indicate if the secretary is signing the directors’ 
report, or one of the directors, along with checkboxes to indicate which directors are 
going to sign the balance sheet. 

If you need to change the presentation of an Officer’s name on the face of the accounts, 
you can use the Name Override task.  This shows a new column in the Officers grid, 
where you can type the exact name as you wish it to appear on the accounts. 



CCH Accounts Production  General User Guide 

 

© 2019 Wolters Kluwer (UK) Limited  65 

Reporting periods 

CCH AP supports reporting for multiple reporting periods within the accounting period. 
This allows the production of regular management accounts, such as monthly or 
quarterly. 

From the CCH AP Homepage, select Reporting Periods from the Actions panel and the 
following dialog will be displayed. 

 

By default, all accounting periods have 1 reporting period representing the whole 
accounting period. This will have a period end date that equates to the accounting 
period end date. If you are only preparing annual accounts then you do not need to 
make any changes to this. 

If you wish to report over multiple reporting periods, enter each period end date in the 
entry line. E.g. for quarterly accounting for the data shown above, you would enter: 

 31/12/2016 

 30/09/2017 

 30/06/2017 

Resulting in 4 periods being shown. 

As you enter each period, the system will ask you if you wish to profile transactions, this 
will automatically allocate any existing transactions to the appropriate accounting 
period based on their date. 

If there are no transactions, or they all fall in the first reporting period, all reporting 
periods will remain open. If there are existing transactions and any fall in periods after 
the first period, the system will automatically close any earlier periods. 

During data entry, if reporting periods exist, the system will default to posting the data 
you enter to the first open reporting period. You can post to prior periods by selecting 
an earlier period from the drop down list. 
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When you have completed entries to the current period, you can close it and move 
forward to the next reporting period using the Roll forward option from the Actions 
panel of the Homepage. If you do this in error you can use Roll Back to reverse this. 
Note that you will not be able to roll back once you have posted transactions to the new 
period. 

Note: if you use reversing journals, these will be automatically reversed when you roll 
forward. 

You can use the predefined reporting periods to generate saved trail balances and 
report on the figures. 
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Financial Statements 

The Financial Statements option provides you with access to routines to maintain the 
report formats, preview and print accounts and other financial statements. To access 
the routines, select Financial Statements from the Financial Reporting group on the 
CCH AP Task Bar. 

Financial Statements Main View 

The grid shows the formats that make up the selected Collection.  

Collections 

A collection is a group of formats that together make up the financial report to be 
produced. Any number of collections can be present for an entity and our master packs 
are shipped with standard collections representing the main reports that you will want 
to produce. For example, the FRS102 Limited Company master pack is shipped with the 
following collections: 

 

To display a list of the formats in a collection, select the collection name from the drop 
down list. 

In addition to the standard collection, you can add your own collections at a client level. 
To do this, select Add Collection from the Actions panel. The system will ask you to 
provide a name for the collection and it will be added to the list. 

Initially, the collection will be empty, but you can add, edit and copy formats as 
described below to populate it with the required formats.  
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Format list and preview panel 

The format list contains the list of formats in the selected collection. Formats can have 
conditions on them which will automate the inclusion of relevant formats in a financial 
report. Any format that will be included when the report is previewed or printed is 
marked with a tick in the Print column. 

If you would like to see only the “active” formats in the collection, you can enable View 
Active Formats. Once clicked it will remember this for that user, for all accounting 

periods/clients from then onwards. You can deactivate this by clicking on the View Active 
Formats button high-lighted in the ribbon. 
 
 

 

 

The panel to the right of the list shows a preview of the selected format. As only one 
format is being previewed in this panel, page and note numbers will only relate to the 
single format and cross references to notes will not be resolved. These will be correctly 
resolved when you preview the full report. 

The formats selected for the collection will, where appropriate, be driven by the size of 
the organisation as calculated or set in the Statutory Database. In the above screen 
shot, the unaudited accounts would have been for a small company. However, there are 
occasions when there are some disclosures in the accounts where you would like to use 
the rules relating to a large company. You can do this by bringing in the format that 
relates to the disclosures for the large company. This is done using Add Format from the 
Actions panel. 

Add Format 

Select the line in the format grid where you would like to insert the new format, select 
Add Format and the system will present you with the following dialog: 
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Select the collection and size of the company that contains the disclosure format you 
wish to use, say Medium. Scroll, or search, to find the relevant format, select it and 
click on OK. The selected format will be inserted indicating that the disclosures for the 
format relate to a different size organisation: 

 

 

In the example shown, we have inserted a Creditors note based on medium company 
disclosures. We now have 2 creditors notes in the list so we can either exclude the one 
that is not required or remove it from the list. 

Excluding and including a format 

If a format has a tick by it but you do not want to include it in the financial report, point 
to the format, click the right mouse button and select Exclude From Print from the 
popup menu. The tick will change to a blue cross and the format will no longer be 
included. 

You can also force a format to always be included by selecting Include In Print from the 
same popup menu.  A blue tick icon indicates that the format has been force included. 

The final option in this area of the popup menu is to Revert to print condition. This sets 
to format to be included or excluded based on the print condition originally associated 
with the format. 



CCH Accounts Production  General User Guide 

 

© 2019 Wolters Kluwer (UK) Limited  70 

Removing a format 

It is also possible to remove a format form the collection by selecting Remove from the 
popup menu. The system will ask you to confirm that you wish to remove the format 
before completing your request. 

Exporting a format to MS Excel 

You can right click on a format in the grid and select “Export format data to Excel”.  
This may be beneficial as a quick and simple way of getting the data contained within 
the format into Excel for further analysis or manipulation. 

Editing a Format 

You can edit any format to customise it for the client. All formats that have been 

customised are flagged with the icon  in the Local column. 

 

You can view a list of all the localised formats in your database via a Home Page 
Control “Localised Formats”; 

 

This displays all the local formats for every Client (for the most recent 2 accounting 
periods).  It can be sorted or filtered by Employee, Office, format etc to help give you 
visibility of who, where and why formats are bring localised. 

Also, you may use the =LocalFormats() command to display a list of all the local 
formats in the current job.  This command could be added to the bottom of the 
Exception Report format for example.  Please see the 2015.1 Release Notes for more 
details. 

It is possible to allow users to edit some formats whilst preventing them from editing 
specific formats by identifying them as a Protected Format.  If required, this can be 
done via Maintenance > Accounts > Format Designer, right clicking the format you wish 
to protect and select the Protect Format option. 

 

To open a format for editing, double-click the format on the grid and the definition of 
the format will be displayed in a separate tab.  
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By default, the format appears with draft mode off.  This means that any rows in the 
spread sheet that are included based on a condition will not be shown if they would not 
be included in the final report. I.e. the data shown is that which will form the final 
report. 

To expose the suppressed rows, select Draft mode under Tasks in the Tabs Bar. This 
option acts as a toggle to switch draft mode on and off. 

If you edit a format and want to save your changes, you can select Save from the Task 
Bar.  If you have not saved your changes, you will be prompted to do so when you close 
the format. Any edit that you carry out through a client’s accounting period will only 
apply to the accounting period loaded and will make the format local. 

When editing a format, the format toolbar provides cut, copy, paste, undo and redo 
options. The formatting fields and the toolbar are for information only and cannot be 
edited. 

 

Format Toolbar 

Lookup References 

When editing a format, you may see references to certain variable values.  These are 
designed to allow a greater degree of flexibility in the reporting.  If you need to find out 
more information about a specific variable, you can use the lookup tools to help. 

Lookup tools are provided for five types of variable; 

 

 

Name Ranges (for example [a,POOABT]). 

Will show you the nominal codes that make up that range and any nominal balances that 
are present. 
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Statutory Database items (for example #on51 or #cd68). 

Will display the title of the Statutory Database field and its Parent field, along with 
various other properties of the Statutory Item.  There is also a “go to” hyper link to 
open the Statutory Database on the selected field. 

 

Compliance Terms (for example #term2, only valid for IFRS and FRS102 entities).  
Allows user to see details relating to the selected Term. 

 

Words (for example #WD3). 

Allows user to see details relating to the selected Word. 

 

Statutory Range 

Displays which individual statutory database fields are summed within the selected 
Statutory Range. 

Styles 

Each cell has a style attached to it to specify the font settings which will be used on the 
resulting report. Each style has a name to identify it and when you select a cell the style 
name and the formatting settings it contains are displayed in the toolbar. You can 
change the style used for a cell by selecting the cell and choosing a new style from the 
list of styles that appears when you hover over the Styles tab on the right of the spread 
sheet.  

The formatting settings for the style are defined in the Theme that is applied to the 
client. The Theme applied to the client can be changed via the Maintenance  
Accounts  Job Themes menu option. 

You can copy the style assigned to one cell to another easily using the Style Painter 

button on the toolbar;  

Excel Functions 

The spread sheet used for editing formats supports standard MS Excel functions, for 
example =sum(), =average(), etc.  It also supports an additional function for the 
extraction of data from the Accounts Production database, =AP(…), where … is the 
formula to execute. The formula within the AP() function currently follows the syntax of 
the formula used in VAP. The following are some of the most commonly used formulae; 

Nominal Formulae 

The following lists some simple formulae: 

  

=AP(“#ld0010”) 
Returns the name of account 0010. (Note ld is LD 
not ID – if you type LD in capitals, the system 
will capitalise the description.) 

=AP(“a,0010”) 
Returns the balance of account 0010 for the 
current period (a=current period). To return the 
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figure for the comparative period use b as in 
=AP(“b,001”) 

=AP(“a,0010..049Z”) 
Returns the balance of a range of accounts for 
the current period. 

=AP(“a,0010+a,0020”) Returns the sum of the accounts shown. 

=AP(“{a,0010-b,0010}”) 
Returns the difference between the balance on 
the account in the current and prior years. 

=AP(“{(a,0010-b,0010)/b,0010}”) 
Returns the percentage difference between the 
current and comparative years when the cell is 
formatted as a percentage type. 

Range Formula 

Range names exist for every nominal account and can be viewed from the Maintenance 
 Accounts Name Range menu option. Name Ranges are retrieved in formulae as 
follows: 

=AP(“[a,*TOTREV]”) Turnover (current year). 

=AP(“[b,*AE]”) Administrative expenses (comparative year). 

=AP(“[a,*AE]+[a,*DC]”) Total of administrative and distribution expenses. 

=AP(“[a,*TOTREV]-
[b,*TOTREV]”) 

Difference between current and comparative turnover. 

Range Commands 

These allow the descriptions, balances and differences between a range of nominal 
accounts to be displayed using a single formula for each element to be included: 

=AP(“RangeDef,[*AE],s,a,-1,0,ab”) 

 

This command inserts a list of nominal descriptions (in this case based on a name range 
of Administration Expenses) on a number of rows based on the specified range and 
conditions applied. It is normally used in conjunction with the RangeCode formula to 
insert a listing if nominal account balances in a report. 

The structure of the formula is explained below: 

 

RangeDef 
The definitions (long description) of a range of nominal 
accounts. 

,[*AE] 
The range of accounts to be included (the example refers to the 
global range of AE but can also refer to actual nominal codes, 
see below). 

,s 

Optional field to control if subcodes are displayed.  If the “s” is 
included in the command, then each subcode will be displayed.  
If the “s” is deleted from the command, then the balances of 

any subcodes will be consolidated and shown as a single row for 
their parent nominal code. 

,a 
Required field. In RangeCode below, this refers to the period of 
the data to be included, a for current year or b for prior year. 

-1 
-1 (True) or 0 (False) indicating the sort order to use.  If this is 
0 then the data will be sorted alphabetically by nominal code 
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description.  If this is -1 then the data will be sorted by nominal 
code. 

0 
-1 (True) or 0 (False) indicating if rows with zero values are to 
be included. If this is -1 then the test referred to next would be 
ignored. 

ab 

The periods to be scanned for balances on account. In this case 
look at both this year and the prior year and if either has a 
balance include it. If this was just ‘a’ the test would only be 
done on the current year and ‘b’ on the prior year. 

 

=AP(“RangeCode,[*AE],s,a,-1,0,ab”) 

 

As can be seen, this command takes the same format as that for the RangeDef and 
would normally appear in a column where the figures are to appear on the same line as 
the RangeDef command. This command inserts a range of nominal values on a number of 
rows based on the specified range and the conditions applied, as described for range 
def. 

Example 

To list all accounts that make up turnover on a detailed report you would use the 
following: 

 B C D 

10 =AP("RangeDef,[*TO],s,a,-
1,0,ab") 

=AP("RangeCode,[*TO],s,a,-
1,0,ab") 

=AP("RangeCode,[*TO],s,b,-
1,0,ab") 

11    

12  =SUM(C10:C11) =SUM(D10:D11) 

13    

 

As lines are inserted the sum range will be increased. Alternatively you could have 
created the total by referring to the total of the global range using =AP(“[a,*TOTREV])  
and =AP(“[b,*TOTREV]). 

Range Commands using Nominal Accounts 

In addition to using name ranges to insert a list of nominal accounts, you can also 
specify a range of nominal codes. This is achieved by replacing the *RANGE_CODE in the 
above format with a list of codes in brackets. Apart from this the format is the same. 

For the Nominal Descriptions 

=AP(“RangeDef,[(0010..049Z)],s,a,-1,0,ab”) 

Inserts a listing of all accounts in the range 0010 to 049Z where there is an active balance 
in either the current or the prior year for the account. 

For the Nominal Balances 

To insert the balances for the current year next to each account, use: 
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=AP(“RangeCode,[(0010..049Z)],s,a,-1,0,ab”) 

Example 

To list all accounts that make up turnover, based on their account numbers you would 
use the following: 

 B C D 

10 =AP("RangeDef,[(0010..049
Z)],s,a,-1,0,ab") 

=AP("RangeCode,[(0010..049
Z)],s,a,-1,0,ab") 

=AP("RangeCode,[(0010..049
Z],s,b,-1,0,ab") 

11    

12  =SUM(C10:C11) =SUM(D10:D11) 

13    

 

As lines are inserted the sum range will be increased. Alternatively you could have 
created the total by referring to the total of the global range using =AP(“a,0010..049Z)  
and =AP(“b,0010..049Z]). 

 

RangeDif command 

 

The RangeDif command is used in variance analysis to show the difference between two 
periods. 
 
If the command is: 
=AP("RangeDif,[*TOTREV],u,q,0,uqab") 
 
Then it prints a value if any of balances u, q, a or b are nonzero. Further parameters , S 
(optional) for include sub accounts can be added as the 7th parameter and ,Deb or ,Cred can 
be added as an 8th parameter. 
 
Further detail can be found in the Help documented here: 
https://www.help.cch.co.uk/003_CCH_Accounts_Production/020_Getting_Started/120_Wo
rking_with_Formats/050_Formulae/RangeDif_and_Dif_commands 
 

ColumnFlex Command – automatic adjustment of column width 

Some pages have a variable number of columns. In this situation, it is common to 
want the rightmost column on each page of the accounts to line up. In the past this has 
been done by inserting formulae that count how many numeric columns are going to 
print and then increasing the width of an earlier description column by the width of the 
suppressed columns. Changing the column width of the description column was 
complicated. It required using one WC command for each number of numeric columns 
that could be printed. The ColumnFlex command is designed to simplify this. 

Suppose we have the following columns: 

Col1 | Col2 | ColumnFlex(1.2) | Col4 | Col5 | Col6 | Col7 | Col8 

https://www.help.cch.co.uk/003_CCH_Accounts_Production/020_Getting_Started/120_Working_with_Formats/050_Formulae/RangeDif_and_Dif_commands
https://www.help.cch.co.uk/003_CCH_Accounts_Production/020_Getting_Started/120_Working_with_Formats/050_Formulae/RangeDif_and_Dif_commands
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Where some of columns 4 to 8 will be suppressed using a CS command if they contain no 
figures. When some of these columns are suppressed, we wish to add their column 
widths to the width of column 3 so that the right edge of the last printed column 
remains the same as on other accounts pages. All that is required is the following 
command in column 3: 

=ColumnFlex(1.2) 

This command tells the system to adjust the width of column 3 so that the 
rightmost column lines up with right margin of the page and to ensure that column 3 is 
at least 1.2 inches wide. 

Notes 

• The command does not use the =AP("...") syntax. 

• If too many columns are printed to allow the ColumnFlex command's minimum 
column width in portrait mode and the page Orientation in Page Setup is set to 
Autodetect, then the page automatically switches to landscape. 

• It is possible to use the ColumnFlex command to distribute the width of 
suppressed columns across more than one column. For instance consider the 
following columns: 
 
Col1 | Col2 | ColumnFlex(1.2) | Col4 | Col5 | ColumnFlex(0.5) | Col7 | Col8 
 
The width saved by the suppressed columns is distributed to columns 3 and 6, 
ensuring that column 3 is at least 1.2 inches wide and column 6 is at least 0.5 
inches wide. The width is distributed proportionately, i.e. in the ratio 1.2:0.5 
between columns 3 and 6. 

• The ColumnFlex command was introduced in version 2017.4 and an example can 
be seen in the FRS102 Statement of changes in Equity (SOCIE). 

Example used in FRS 102 Limited - Statement of changes in Equity (SOCIE) – 

Page7soce 

Page Setup – Orientation set to Autodetect 

Cell B2 – formula added to cell: =ColumnFlex(1.6) 

Columns D to L return a 1 or 0 based on whether anything printing in the particular 
column. 

Column M – is the Total column and the formula in cell M2 tests if a Total column is 
required i.e. there are more than one column printing =IF($B$1<=1,AP("cs"),"print"). Cell 
B1 counts the number of columns printing and is used as a reference for the Total 
column.  
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Referencing Data from a Saved TB or a Budget 

It is possible to modify the above commands so that instead of returning the current 
year-to-date balances or comparative year balances, the commands return data from a 
saved trial balance or a budget which you have previously created.  To do this, simply 
amend the command and replace the accounting period letter (ie “a” for current year, b 
for comparative”) with the User Defined Reference.  For example; 

 

=AP(“[g,*TOTREV]”) 

This will return the Turnover balance for the data set (either a saved trial balance or a 
budget) which has been assigned the user defined reference "g". 

For more complex commands, such as RangeDef and RangeCode, make the following 
changes; 

Original command;  =AP("RangeDef,[*TOTREV],S,a,-1,0,ab") 

Amended command;  =AP("RangeDef,[*TOTREV],S,g,-1,0,abg") 

 

You may wish to use the “Edit and Replace” feature to update several commands on a 
format in bulk.  To do this, highlight the column or cells, right click and select 
“Find/Replace…”.   

• Enter the text to find, for example to replace the current year “a” you should 
enter find “a,”.   

• Enter the text to replace, to point to the user defined reference “g”, enter 
“g,”.   

• Then click Replace All. 

 

 

Images 

It is possible to display an image on the face of the accounts, such as a logo or graph.  
AP supports .png, .jpeg, .jpg and .bmp image files. 
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The images you wish to print can be uploaded to the Image Library, click Maintenance > 
Accounts > Images. 

To reference an image from the library on the face of a format, use the =IMAGE 
command. 

This command has various parameters that control the image’s size and its position on 
the format. 

An example image command is shown below for reference; 

=IMAGE("CCHLogo","100%","Page","Right","Top","1cm","1cm") 

 

The =IMAGE command may also be used in conjunction with a Theme to define an image 
which prints in the header or footer of multiple formats. 

For full details, please see the Accounts Production 2014.1 Release Notes. 

Tables 

If you wish to include a table within the financial statements, for example as part of a 
Trustees Report, this can be done as follows. 

AP does not allow you to ‘design’ the table itself.  Instead you must first create the 
table within MS Word, and then the table to can copied and pasted into a Statutory 
Database paragraph within AP. 

The table data can then be edited within AP, but its structure cannot (e.g. you cannot 
add a new column). 

The table may contain an AP command such as AP(“#cd2”) or AP(“[a,*TOTREV]”), which 
will then be evaluated when previewing the accounts. 

However please note that the formatting of the result of such commands will be 
determined by the Style in use on the cell in which the statutory database paragraph is 
referenced.  Only a single Style can be used which may limit the presentational control 
of the contents of the table. 

The table will be rendered correctly in Review & Tag, and the content of the table can 
also have individual tags applied to it if required. 

Previewing/Printing/Saving Financial Reports 

To preview a single format, first open the format for editing and then select 
Preview/Print from the Task Bar. 

To preview a the full report generated by the collection, select the Collection Name 
using the drop-down list and click Preview/Print to view the report. From the preview, 
you can select the print icon in the toolbar or save the preview to PDF or Docx. 
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Other options in the toolbar allow you to zoom in and out and show the report in various 
preset modes.  

Drill down from preview 

If you point to a print element in the preview and click the left mouse button, the 
system will drill down to the source of that element of the report and allow you to edit 
it. For example, if you click on the principal activities text, you will see the following 
edit dialog: 

 

 

If you click on text that has been drawn from a cell in a format, the format will be 
displayed in a separate tab. 

Clicking on figures will drill down to a dialog listing the nominal accounts that make up 
the figure. 
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Export to PDF/Word 

The option Print to Pdf/Docx in the Actions panel allows you to save the Financial 
Statements as a PDF or MS Word file. To do this, select the Collection and click Print to 
PDF/Docx and the Save As dialog will appear. Choose the format that you wish to 
generate form the Save as type drop-down, specify the file name, and then click Save. 

If you wish to apply encryption to the resulting PDF, then choose the Pdf Document 
[Encrypted] option, and you will be prompted to enter and confirm a password. 

CCH Document Management 

If you have purchased CCH Document Management, you will be prompted at this point to 
upload the PDF or Docx file to the Document Centre. 

Alternatively you may directly upload the set of accounts to the Document Centre by 
clicking the action “Publish to DM”. 

CCH Portal 

If you have purchased CCH Portal, you can publish the accounts to the Portal by 
selecting the “Publish to Portal” task.  You can also set if the accounts require approval 
from the recipient.  Any subsequent approval action can act as a trigger within CCH 
Workflow to advance to the next step in a process. 

Resetting/Reverting collections 

If you have changed a collection by adding and removing formats, you may wish to 
return the collection back to its original state containing the list of default formats. 
There are two ways to do this; Reset Collection or Revert to Default. 

To do this, select the collection to reset in Collection Name and click on Reset 
Collection or Revert to Default from the Actions panel. The will result in the behaviour 
listed below. 

The can be used to, for example, revert back to the default Creditors note that was 
change to that for a Medium company in Add Format above. 

 

Reset Collection (soft); 

• local formats - will remain in the collection 

• force include/exclude (print condition has been overridden) - no change to the 
overridden print condition 

• removed format from FS collection - removed formats will come back into the 
collection 

• new format (added into Format Designer collection) - new formats will appear in 
the collection 

  

Revert to default (hard); 

• Local formats - will be removed from the collection 

• force include/exclude - all print conditions will be reverted back to master 
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• removed format from FS collection - removed formats will come back into the 
collection 

• new format (added into Format Designer collection) - new formats will appear in 
the collection 

 

Revert to default is only accessible for users with access to the Task Permission 
#Financial Statements #Revert Collection and a warning message will be displayed; 
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Budgets 

The Budgets option allows you to record an unlimited number of budgets for the client. 
These can then be referenced on the face of financial statements.  

To Create a Budget: 

1. Select Budgets under Reference in the CCH AP Task Bar 

2. Click Add new budget in the Actions panel and the Add Budget dialog appears: 

 

Add Budget Dialog 

3. Enter a name for the budget e.g. Jan. 

4. To enable you access these figures in Financial Reports, enter an optional User 
Reference in the User defined reference field. The reference entered here can 
be used in formula in financial reporting to pick up the budget for inclusion in 
reports. References A to F are reserved, but other than that you are free to use 
references of your choice. Note that in this release references are restricted to 
a single character. E.g. ”K” in the above example. You can use the drop down to 
see a list of any existing references in use. If you enter a reference that is 
currently associated with another source will advised of this and offered the 
option to continue 

5. Click OK. A new budget column appears on the grid with the budget name you 
entered. 

6. Enter the figures in the budget column. 
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General Maintenance 
Options 

A number of maintenance options are accessible from the Maintenance menu. The 
changes you make here are practice level changes and will impact all new clients. Some 
changes, such as changes made in the format designer will also have an effect on 
existing clients. 

To view these options select MaintenanceAccounts: 

 

Maintenance Accounts Menu Options 

 

The following is a brief explanation of the main options: 

◼ Auto Publish – allows you receive future updates from CCH and automatically 
publish them 

◼ Charts  - lists of nominal charts 

◼ Chart Categories – manage nominal categories 

◼ Chart Nominals – manage existing and add new nominals 

◼ Compliance Terminology – maintain the list of compliance terms used for IFRS 
and FRS102 disclosures 

◼ Entities – maintain the lists that appears in the Entity drop-down 

◼ Entity Copy – used to create a new Entity and Master Pack based on a CCH 
Entity 
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◼ Format Designer – allows the editing of all formats (may change existing clients 
if the format changed here is used in an existing clients reports. I.e. it has not 
been localised for the client.) 

◼ Images – loads the Image Library, where you can add and maintain a collection 
of images which can be printed on the accounts 

◼ Import/Export Definition – add and maintain the Nominal Mappings and File 
Structures used when importing or exporting a Trial Balance or transactions 

◼ Job Themes – define and maintain the Themes assigned to clients (changes will 
affect existing clients) 

◼ Master Pack – allows you to create new master pack versions for your entities 

◼ Master Pack Difference Analyser – allows you to compare your current pack 
content with a new pack issued from CCH 

◼ Master Pack Publish – Allows you to publish a master pack version so it is 
available for use in an Accounting Period 

◼ Name Range – add or maintain the list of Ranges (groups of nominal codes) that 
are referenced in Formats (changes will affect existing clients) 

◼ Officer Range – facilitates the creation of multiple nominal codes linked to 
officers within the chart of accounts 

◼ Paragraphs – add or maintain the list of standard Paragraphs used in the 
Statutory Database (changes will affect existing clients) 

◼ Relationship Mapping - specify what addresses appears within the Financial 
Statements (changes will affect existing clients) 

◼ Statutory Auditor – maintain a list of Central Contacts that represent the Senior 
Statutory Auditors used within your firm 

◼ Statutory Database Defaults – set certain parameters to apply to your firm, for 
example Country of Incorporation and Professional Body 

◼ Statutory Database Designer – tool to allow modifications to the design of the 
Statutory Database for copied entities only 

◼ Statutory Range – maintain a list of statutory ranges that are referenced within 
formats.  These are groups of individual statutory database fields 

◼ Themes – define the Themes and Styles that are available to apply to a client 

◼ Virtual Expressions – view a list of date tests that are used within paragraphs 
and formats 

◼ Word Items – add or maintain the dictionary of keywords referenced in 
Paragraphs and Formats 
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Appendix 1 – List of VRM 
values 

VRM Name Test Date 

VRM1 Current Year Start date >= 15/12/2004 

VRM2 Current Year Start date >= 01/01/2005 

VRM3 Current Year Start date >= 01/04/2005 

VRM4 Current Year End date >= 22/06/2006 

VRM5 Current Year End date >= 22/06/2005 

VRM6 Current Year Start date >= 01/10/2005 

VRM7 Current Year End date >= 31/03/2006 

VRM8 Current Year Start date < 01/04/2005 

VRM9 Current Year Start date >= 01/01/2007 

VRM10 Current Year Start date >= 06/04/2007 

VRM11 Current Year Start date >= 06/04/2008 

VRM12 Current Year Start date >= 01/10/2008 

VRM13 Current Year Start date >= 06/04/2009 

VRM14 Current Year Start date >= 01/10/2009 

VRM15 Current Year Start date >= 01/04/2008 

VRM16 Current Year End date >= 05/04/2009 

VRM17 Current Year End date >= 30/01/2004 

VRM18 Current Year End date >= 30/03/2004 

VRM19 Current Year End date >= 26/07/2000 

VRM20 Current Year End date >= 26/05/2004 

VRM21 Current Year Start date >= 17/07/2004 

VRM22 Current Year Start date >= 24/12/2006 

VRM23 Current Year Start date >= 24/02/2007 

VRM24 Current Year End date >= 15/12/2010 

VRM25 Current Year Start date >= 01/01/2010 

VRM27 Current Year Start date >= 01/10/2012 

VRM28 Current Year End date >= 30/09/2013 

VRM29 Current Year Start date >= 01/01/2015 

VRM30 Current Year Start date >= 01/06/2015 
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VRM31 Current Year Start date >= 01/01/2016 

VRM32 Current Year Start date >= 17/06/2016 

VRM33 Current Year Start date >= 01/01/2017 

VRM34 Current Year Start date >= 01/01/2019 

VRM35 Current Year Start date >= 01/01/2018 
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Appendix 2 - General 
Data Protection 
Regulation (GDPR) 

Two features have been added to Central to cater for GDPR compliance. Both are 
accessed from the Main tab of the client in Central:  

• Delete client. Previously you could not delete a client if it had an Accounting 
Period. You had to delete the Accounting Period(s) first.  This was inconsistent with 
some other Central applications. Now you can delete a client with Accounting 
Periods unless the client is part of a group of companies, in which case you are 
asked to remove the client from the group before deletion. 

• GDPR Data Request. Before using this, you need to set up two folders in File > 
Maintenance > Documents > Mail Settings. The folders are called Templates path 
and GDPR path. 

Two buttons are available: 

o Generate PDF. Exports client data into PDF files in a subfolder of the GDPR 
path folder. For CCH Accounts Production, files are generated for the trial 
balance and a set of accounts.  

o Generate XML. XML files are generated for the client in the same folder. 
Again for CCH Accounts Production, files are generated for the trial balance 
and a set of accounts. 

Notes 

• If you are licensed for CCH Document Management, then the files are uploaded into 
Document Management rather than being saved in the folder. 

• There are options for exporting files just for the Current Year and for Other Years. 
So for all years, tick both. 

Further details are available in the Central Release Notes. 


